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Chapter 1
Important Information

Please read before installing or using Windows Write.

Keynames and Terminology

You may notice some small terminology differences between this document and
the other PCSA documents.

Generally, the keys referred to in this book correspond to the keys with the blue
legends on the LK250 keyboard. However, the following keys are different:

1. The ENTER key mentioned in this document corresponds to the RETURN
key on the LK250 keyboard.

2. The BACKSPACE key mentioned in this document corresponds to the <X]
key on the LK250 keyboard, and to the 4— key on AT, XT and Enhanced
keyboards.

Installing MS-Write

MS-Write is installed as part of your client software installation procedure.

(1]



Important Information

Using Microsoft Word Files with Windows Write
Working with Text Files

If you use Windows Write to open a text file, you will be asked whether or not
you want the file converted into Windows Write format. If that text file was
created by a Windows application, do not convert it into Windows Write format.
If it was not created by a Windows application, you need to have it converted
into Windows Write format.

Converting a Word File to Windows Write

(2]

Windows Write has a built-in conversion utility to convert files formatted using
Microsoft Word into Windows Write Format. If you try to load a Word file
under Write a dialog box will appear. The dialog box asks if you want the file
converted into Windows Write format. You have the following options:

e Convert

¢ No Conversion
*  Cancel

¢ Make Backup

If you choose to make a backup copy of your document, you will create a copy
of the original file with the extension .BAK. This backup copy will have the same
format as the original file, i.e. if the original file was a Word file, the backup
copy will be in Word format, while the copy you are working with under Write
is now in Write format.

CAUTION

If you have any special graphics formatting characters in your Word
document, they will not be displayed correctly by Windows Write.
You should make a backup copy of your document and then convert
the document to Write format. If you see incorrect characters on the
screen, you can erase them. Use the Windows package to create any
graphics images that you want to go into your documents.



Important Information

6 Saving a File with Windows Write
(See Windows Write User’s Guide, Chapter 1)

When you save the file you are working with, you have the option of saving it
in Microsoft Word format. When you choose the SAVE option from the FILE
Menu, you will get a dialog box with the following options:

1. Make Backup
2. Text Only
3. Microsoft Word Format

If you have any graphics in your Write document (that includes any text created
under Paint, or any other Windows graphics package) and you try to save it in
Microsoft Word format, you will get a dialog box warning that the picture or
graphics will be deleted. You have the option to cancel or save. If you choose to
save the picture or graphics, it will not be saved as part of the document. If you
want your picture or graphics saved, you need to make a backup of the document
under a different name, and save it as a Windows Write document.

Options 1 and 2 are explained in the Windows Write User’s Guide, Chapter 1.
Option 3 will allow you to save that file in Microsoft Word format. To save a
file as an unformatted Microsoft Word file, choose both options 2 and 3. Please

ﬁ@\ refer to your Microsoft Word manual for more information on saving files with
the ‘‘unformatted” option.

CAUTION

If you choose the Backup option when you open a file under
Windows, DO NOT use the Make Backup option when you save the
file. If you do, the original backup copy of the file will be erased. If
you wish to make a backup, please save the file under another name.

(3]



Important Information

Metric Measurement Support

Microsoft Windows Write has built-in support for metric or English
measurements. To choose or change the measurement setting, go to the ‘‘page
layout™ option in the Document Menu. Write will prompt you with a dialog box
that has, in addition to the page formatting information, two radio buttons: one
for Inch and the other for Cm. Choose the measurement system that you prefer.

CAUTION

You only need to do the conversion once. Once the text file has been
saved as a Windows Write file, do not do this conversion again. If
your file was saved under Microsoft Word format, you need to do the
conversion when you load it again under Windows.

Opening a Write Document from the MS-DOS Executive
(See Windows Write User’s Guide, Chapter 1)

The Windows Write User’s Guide states that a document must be in the same

directory as WRITE.EXE. This is not a requirement as long as WRITE.EXE is

in the Path entry in your MS-DOS AUTOEXEC.BAT file. For more information

on placing entries in your AUTOEXEC.BAT, refer to the MS-DOS Reference

Manual. If you have a question about Windows and you can’t find the answer in

your manuals, contact the Microsoft office for your country. They will be ready /ﬁ%)
to give you the support you need to get the most from your Microsoft software. /
If you call or write to Microsoft, please let them know:

*  The product number on your disk label

¢ Which Windows manuals you are using

Printing an MS-Write file that Contains Raster Graphics

Any graphics you create using MS-Paint, and then incorporate into an MS-Write
file, can only be printed on a device that supports raster graphics.

(4]
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Windows Write is a writing program for Microsofte Windows.
With Write, you can write, edit, and print all kinds of documents
for business and personal use. Because it runs in the Windows
environment, Write gives you some unique advantages, such as
pasting information or graphics from other applications into your
Write documents to make your documents more informative and
eye-catching.

Write uses the familiar conventions of the Windows environment:
command menus, dialog boxes, icons, and the Windows System
Menu. You will find that using Write is a natural extension of
using Windows. Write makes it easy to accomplish all your day-
to-day writing tasks.



vi Welcome

About This Manual

This manual describes how to use Write to create, format, save,
and print documents. It gives you a step-by-step procedure for
every task you can perform with Write.

Throughout the manual, you will see sections called “Now Try
This.” If you want, you can do the exercises in these sections to
practice your skills before applying them to your own documents.

The manual is divided into six chapters:

® Chapter 1, “The Basics,” introduces you to the Write window
and describes how to choose commands. It tells you how to
open and save documents and how to end a Write session.

B Chapter 2, “Editing 2 Document,” describes how to enter text,
scroll through a document, and select text. It also tells you
how to insert, delete, move, copy, and find text.

8 Chapter 3, “Formatting Your Work,” describes how to use
Write’s formatting abilities to give your documents the appear-
ance you want.

B Chapter 4, “Pasting from Other Applications,” describes how to
copy text or graphics from other Windows applications into
Write documents. Specific examples illustrate how pasting
works with different types of applications.

B Chapter 5, “Printing a Document,” explains how to print and
paginate your documents and how to change printers.

B Chapter 6, “Command Summary,” gives a brief description of
the Write commands in the order they appear on the menus.
It also reviews the various methods for choosing commands.

An appendix, “Fonts and the Current Printer,” describes how
Write uses fonts with different types of printers.



If you want to

About This Manual vii

See

Review how to choose Write
commands

Open a document

Start typing text
Edit a document

Change the appearance of your
document

Paste information from another
application into a Write docu-
ment

Edit a Microsoft Word docu-
ment in Write

Save a document

Print a document

Close the Write window

Learn more about Write
commands

“Choosing a Command” in
Chapter 1

“Opening a Document” in
Chapter 1

“Typing Text” in Chapter 2
Chapter 2, “Editing a
Document”

Chapter 3, “Formatting Your
Work”

Chapter 4, “Pasting from Other
Applications”

“Using Windows Write with
Microsoft Word” in Chapter 4
“Saving a Document” in
Chapter 1

Chapter 5, “Printing a
Document”

“Ending a Write Session”
in Chapter 1

Chapter 6, “Command
Summary”

You can use Windows Write with or without a mouse. Where
appropriate, this manual describes a procedure with the keyboard
and with the mouse, so you can learn either or both techniques.
If your mouse has more than one button, use only the left button

with Write.

This manual assumes that you already know how to use your
Microsoft Windows system and that you have read the Microsoft

Windows User’s Guide.



viii Welcome

Running Write with a
two-drive system

Getting Started

Windows Write includes:

B Windows Write disk
B Microsoft Windows Write User’s Guide

To run Windows Write, you need Microsoft Windows installed
and running on your computer.

For more information on what you need to run Microsoft Win-
dows, see the sections “What You Need” and “Getting Started” at
the beginning of the Microsoft Windows User’s Guide.

Running Write with a Two-Drive System
To run Write with a two-drive system:

(1 If you have not started Windows, insert the Windows Startup
disk in drive A and the Windows System disk in drive B.

[2] At the A> prompt, type win

Windows starts and the MS-DOSe Executive window appears.
[3] Take the Startup disk out of drive A and insert the Write disk.
[a] Select drive A in the MS-DOS Executive window.
(5] Select and run WRITE.EXE.

Note If you have already started Windows and you want to run
Write, put your Write disk in drive A and follow steps 4 and 5
above.

Store the documents you create with Write on the Write disk in
drive A. The disk has about 150K bytes free for documents. When
you want to start a new document disk, copy WRITE.EXE to a
new disk. Then use that disk for running Write and storing docu-
ments. When you have about 50K bytes remaining on your Write
disk, you should start a new disk.

To copy WRITE.EXE to a new disk:

[A] Select drive A in the MS-DOS Executive window.
[2] Select WRITE.EXE.



(3] With the Windows System disk still in drive B, choose Copy
from the File Menu in the MS-DOS Executive.

You will see a dialog box.
(4] In the dialog box, type b: in the To text box.
(8] Put a blank, formatted disk in drive B.
[6] Choose the Ok button.
Windows copies WRITE.EXE to the blank disk in drive B.

When WRITE.EXE has been copied, put the Windows System
disk back into drive B and put the disk with the new copy of
WRITE.EXE in drive A.

Warning Never remove the Write disk while you are in the pro-
cess of editing a document with Write. There are only two times
when you can remove the Write disk without risk of losing your
work:

B When the Save dialog box is on the screen
B When the Open dialog box is on the screen

Then, you can change disks if you want to save your document
on a different disk or open a document that is on a different disk.
Otherwise, do not remove the Write disk during an editing
session.

Running Write with a Hard Disk System

If you have run Windows Setup, WRITE.EXE should already be
copied onto your hard disk. If WRITE.EXE is not on your hard
disk, use the DOS COPY command to copy WRITE.EXE to a di-
rectory on your disk. Then you can run Write from the MS-DOS
Executive window as you would run any application.

To run Write with a hard disk system:

[1 Open the MS-DOS Executive window.
(2] Select and run WRITE.EXE.

Getting Started ix

Running Write with
a hard disk system



1 The Basics

This chapter introduces you to the Write window and reviews the
techniques for choosing commands. It also describes how to open
a new or existing document, how to save a document on the disk,
and how to close the Write window.

In this chapter:

B The Write window

® Opening a document
B Saving a document

B Ending a Write session



2 The Basics

1.1 Write Window

The Write Window

When you start Write, the screen looks like this:

Insertion point
System menu box Size box
Menu bar

Icon area Horizontal Vertical scroll bar
Page status scroll bar Size box
MS-DOS Executive icon Mouse pointer (appears

only if you have a mouse)

Choosing a Command

Write commands are organized into menus on the menu bar. You
choose commands in Write just as you do in the MS-DOS Execu-
tive or the Windows Desktop Applications.

If you want to review how to choose commands in the Write win-
dow, read the steps given here for the keyboard or the mouse. For
complete information on choosing commands, see Chapter 6,
“Command Summary.”



The Write Window 3

With the Keyboard

W\ To choose a command with the keyboard: Choosing a command
“ with the keyboard
[ Press the ALT key and the first letter of 2 menu to open the

menu.

For example, pressing ALT-F opens the File Menu. To open the
System Menu, press ALT-SPACEBAR.

[2] Release the keys.
The menu stays open.
[3] Press the first letter of a command on the menu.

For example, pressing N selects the New command on the File
Menu. If two commands have the same first letter, press the
letter twice to select the second command.

1.2 New Command
Selected on File Menu

Gpen. ..
Save...

Print...
Change Printer...
Repaginate. ..

[a] Press the ENTER key to carry out the command.

If the command needs more information, you will see a dialog
box. See “Using Dialog Boxes” below for more information.

To close a menu or a dialog box without carrying out a com-
mand, press the ESC key.

With the Mouse

To choose a command with the mouse: Choosing a command
with the mouse
[1 Point to 2 menu name and press the mouse button.

[2] Drag down to the command you want.
[3] Release the mouse button to carry out the command.

If the command needs more information, you will see a dialog
box. See “Using Dialog Boxes” below for more information.



4 The Basics

Using Dialog Boxes

When you see a Write dialog box, you select options or list box
items, and fill in text boxes to complete the command, just as you
do with the dialog boxes in the Windows Desktop Applications.

If you want to review how to use dialog boxes, read the examples
below for the keyboard or the mouse.

With the Keyboard
To fill in a dialog box with the keyboard:

Press the TAB key to move the flashing underscore or insertion
point from one part of a dialog box to another. Then select
an option or list box item, or fill in a text box, as shown in
Figure 1.3.

You type text in a text box.
Pressing the EnTEr key from anywhere in the
dialog box chooses the bold button.

1.3 Filling In a Dialog Box
with the Keyboard

Text Box [ ERUL0E ' |

Light Switch  [FIRST
o 001 —

4
i
8% /e
L4

To choose a button, move the underscore to
that button and press the SPACEBAR.
Select an item in a list box with the pirRecTION keys.
The selected item is highlighted.
You can select or deselect any number of check boxes. Press the
SPACEBAR to select and deselect.

You can select only one from a group of option buttons. Use the biRecTioN
keys to move from one to another.
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With the Mouse

To fill in a dialog box with the mouse:

Click the option or list box item, or fill in a text box, as shown
in Figure 1.4.

You can scroll the list

You type text in a text box. with the scroll bar. 1.4 Filling In a Dialog Box

with the Mouse

Light Switch

e
®0n

THIRD
/‘ O0ff FOURTH
Clothing

To choose a button, click it.

The selected item in a list box is highlighted.
You can select or deselect any number of check boxes.
w You can select only one from a group of option buttons.

Opening a Document

You can open documents with the New command or the Open
command from the File Menu. The New command is for opening
a new untitled document. The Open command is for opening a
document that is already stored on your disk.

You can also open a new or existing document from the MS-DOS
Executive window.

Opening a New Document Opening a new

document
When you run WRITE.EXE from the MS-DOS Executive window,

Write begins with a new untitled document. While you are using
Write, you can open a new document with the New command.

To open a new document from Write:

Choose New from the File Menu.
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Opening an existing
document

1.5 Open Dialog Box

Opening an Existing Document

|
With the Open command, you can open a document you have
saved. You can also open different disk drives and directories to
gain access to documents stored in them.

To open an existing document from Write:

(1] Choose Open from the File Menu.
You will see this dialog box:

To scroll the list box, use the
Documents scroll bar or the up or bown keys.

1

t\windows

Directories
Next higher directory (parent directory)
Disk drives

[2] Select the name of the document you want to open.
[3] Choose the Open button to complete the command.

Or, with the mouse, double click the name of the document
you want to open.

If you open a document name, Write opens the document.

If you open a disk drive or directory, Write makes it the default
disk drive or directory and displays the contents in the list box.
Select again and choose the Open button. This way, you gain
access to documents that are not on the current disk drive or in
the current directory.



Opening a Document from the MS-DOS Executive

You can also run Write and open a document at the same time
from the MS-DOS Executive window. The document must be
stored in the same directory as WRITE.EXE.

To open an existing document from the MS-DOS Executive:

Expand the MS-DOS Executive window.
[2] Select a Write document name and press the ENTER key.

Or, double click the document name with the mouse.

Opening More Than One Write Window

You can have more than one Write window open at a time. To
do this, you need at least 512K random access memory in your
computer.

To open an additional Write window:

[1] Begin with a Write window open on your screen.

[2] Expand the MS-DOS Executive window so that it shares the
screen with the Write window.

[3] Select and run WRITE.EXE.

Paragraph  Document

Classm old world charmer, 2 bedrooms plus mast 4
unfinished basement with washer and dryer. All 3

C:ALEWISCOMM \windous

BETA EMPLOY . MSP good location, close to schools and freeway.
NEXO EPSON, EXE negotiable. Richmond Beach area, $70,000. ¥
M3T00L3 FORMATS, DOC
PF HIRAGANA. DOC
TRYIT HIRAGANA, MSP
ABC, TXT HOUSE, DOC

ANA. DOC

CALC, EXE KANA,
CALENDAR, EXE  NEC3590. EXE
CARDFILE, EXE NOTEPAD, EXE
CI.IPBRD EX PAINT, EXE
CLOCK, EX
CONTROL EXE

Page 1

Press the ENTER key to open another Write window.

Opening a Document 7

Opening a document
from the MS-DOS
Executive

Opening more than
one Write window

1.6 Opening an Additional
Write Window
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1.7 Save Dialog Box

[4] Open a document in the new Write window.

Note If you have the same document open in two different
windows, you will see your changes only in the window you
are working in. The document will not be updated in the other
window unless you close and reopen it.

Saving a Document

When you save a document, Write stores the latest version of the
document on the disk.

You will usually want to save your Write document before you
close the Write window or open another document. It is also a
good idea to save often while you are working with Write. Saving
frequently helps Write perform faster, and it minimizes lost work
if there is a power interruption.

To save a document:

(il Choose Save from the File Menu.
You will see this dialog box:

Type document name here.

Sape Current Document fs: C:\WINDOUS
B [ Save )

[1Make Backup

Check here to make a backup copy.

Check here to save without formatting (for example, if your document is
a program or will be telecommunicated).

[2] Type the name you want the document to have.

If the document already has a name, Write proposes that name.
See “Document Names” below for more information.

(8] Choose the Save button to carry out the command, or press
the ENTER key.



If you enter a name that already exists in the current MS-DOS
directory, Write asks if you want to replace the existing file.
Choose the Yes button only if you want to delete that file and
replace it with the document you are saving. Otherwise, choose
the No button and type a different document name.

While saving, Write briefly displays the number of characters con-
tained in the document. The number appears in the lower-left
corner of the window, where the page status usually appears.
After saving, Write returns to the document so you can resume
working.

Document Names

Keep in mind the following guidelines when you create a name
for a Write document.

B The characters in a document name can be letters or numbers.

You can enter the letters in upper or lower case, but Write
always displays them in upper case.

® A name can have up to eight characters, plus an extension.
An extension always begins with a period and can have up to
three characters.

B Write automatically adds the extension .DOC for you. This
extension is a good way to identify all your Write documents.
If you add your own extension when you save the document,
or if you just end the name with a period, Write does not add
.DOC.

Saving More Than One Version

If you change a document, but want to keep the old version on
the disk as well as the new version, you can use the Save com-
mand to give the new version a slightly different name. For
example, the new version of RESUME.DOC could be named
RESUME2.DOC.

To save more than one version of a document:

[1 Choose Save from the File Menu.

[2] Type the name for the new version of the document in the
text box.

8] Choose the Save button to carry out the command.

Saving a Document 9

Document names

Saving more than one
version
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Saving a backup copy

Saving text only

Saving to a different
disk drive

Saving a Backup Copy

You can use the Save command to make a backup copy of your
document. You must save the document one time before you
can make a backup copy. The backup copy is the version of the
document that was saved with the previous Save command. The
backup copy has the same name as the document and the exten-
sion .BAK.

To save a backup copy:

(] Choose Save from the File Menu. Write proposes the current
name of the document.

(2] Select the Make Backup check box.
(3] Choose the Save button to carry out the command.

Saving Text Only

You can ask Write to save only the text in your document,
without the formatting. You may want to eliminate formatting if
your document is a program or if you will be telecommunicating
the text to another computer. Or, you may want to move unfor-
matted text to another WIN application and format it there.

To save text only:

(] Choose Save from the File Menu.
[2] Select the Text Only check box.
(3] Choose the Save button to carry out the command.

Saving to a Different Disk Drive

Normally, Write saves documents to the current disk drive, which
is the drive containing WRITE.EXE. If you have a hard disk, you
can save to a different disk drive by preceding the document
name with the drive letter and a colon.

Note If you have a two-drive floppy disk system, do not save to
a different disk. You must always save your documents on the
Write disk in drive A. If you have a hard disk system you may
want to save to a disk in drive A or B.



To save to a different disk:

[1] Choose Save from the File Menu.

[2] Type the name of the document preceded by a letter and
colon for the drive you want to save to.

For example, type B:RESUME.DOC to save RESUME.DOC on
the disk in drive B.

[3] Choose the Save button to carry out the command.

Saving to a Subdirectory

Normally, Write saves documents to the current directory. You
can save a document to a subdirectory by preceding the docu-
ment name with a subdirectory name and a backslash.

To save to a subdirectory:

[i Choose Save from the File Menu.

[2] Type the subdirectory name, a backslash, and the document
name.

For example, type JOBS\ RESUME.DOC to save the document

RESUME.DOC in the subdirectory JOBS. JOBS must be a sub-
directory in the current directory.

[3] Choose the Save button to carry out the command.

The subdirectory you specify must already have been created with

MS-DOS. Write will not create the subdirectory for you.

Ending a Write Session 11

Saving to a
subdirectory

Ending a Write Session

When you are finished using Write, close the Write window.
To close the Write window:

Choose Close from the System Menu.
Or, double click the System Menu box with the mouse.

If you have unsaved changes in the document, Write asks if you
want to save them before closing.

If you end the Windows session without closing the Write win-

dow, Windows closes it for you. If you have unsaved changes in a

Write document, Windows asks if you want to save them before
ending the session.

Ending a Write
session



2 Editing a Document

This chapter tells you how to type and edit text with Write. Edit-
ing techniques include deleting, inserting, moving, and finding
text. You can practice each technique by working through the
sections called “Now Try This.”

In this chapter:

Typing text

Scrolling and selecting text
Deleting text

Inserting text

Moving and copying text
Finding and changing text

Undoing your last action

13



14 Editing a Document

Typing text Typing Text

To type text with Write, start the program, then start typing.
There are several things to keep in mind:

B As you type, text appears to the left of the blinking insertion
point.

B If you make a typing mistake, press the BACKSPACE key. It erases
characters as it backs over them.

B Press the ENTER key only when you want to begin a new para-
graph, leave some blank lines, or begin a new line before you
reach the right margin.

You do not need to press the ENTER key when you reach the
end of each line because Write automatically starts the next
line for you. This is called wordwrap. Each time you reach the
right margin, the insertion point and the word you are typing
automatically move to the next line.

Now Try This

(1] Start Write as described in “Getting Started.”

(2] Type the paragraph shown below. Do not press the ENTER key
as you type. To erase typing mistakes, press the BACKSPACE key.

2.1 Typing Example trite - (Untitled)
File Edit  Search  Character  Paragraph  Document

Just listed this week - a house that has to be seen to be believed! Callnow! Richmond Beach
area, $70,000. Classic old world charmer, 2 bedrooms plus master bedraom, fireplace, hardwaod

floars, unfinished basement. Allappuancesmurapes included. Private ot in good location,
close fo schools and freeway. Cail Jim Murphy at 999- 77770

The text on your screen may not look exactly like the text
shown here. This is because Write displays text in different fonts,
depending on the current printer. For more information, see the
Appendix, “Fonts and the Current Printer.”
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Scrolling and Selecting Text

Scrolling is the process of moving the document text through
the window. Selecting is the process of highlighting text on the
screen. You want to be able to scroll efficiently so you can go
where you want in the document. You want to be able to select
text easily because many commands and actions with Write
require you to first select text.

rite - (Untitled)

2.2 Selected Text
Character  Paragraph

=]
File Edit  Search Document

Just listed this week -- a house that has to be seen to be believed? Call now! Richmond Beach
area, $70,000. Classic old world charmer, 2 bedrooms plus master bedroom, ﬂremace hardwood
floors, unfinished basement. CET AT LR E A ATl Frivate totin good location,
close to schools and freeway. Call Jim Murphy at 999-7777.X

Selected text

Scrolling and Selecting with the Keyboard

The following lists show you how to move the insertion point,
scroll a document, and select text with the keyboard.

Moving the Insertion Point

To move

Press

Left, right, up, or down

To the next or previous word

To the beginning or the end of
the line

To the next or previous sen-
tence

To the next or previous para-
graph

To the top or bottom of the
window

A DIRECTION key: LEFT, RIGHT, uP,  Moving the insertion

or DOWN point with the
CTRL-RIGHT Of CTRL-LEFT keyboard
HOME or END

GOTO-RIGHT or GOTO-LEFT (The
GOTO key is the 5 on the
keypad.)

GOTO-DOWN or GOTO-UP (The
GOTO key is the 5 on the
keypad.)

CTRL-PAGE UP Or CTRL-PAGE DOWN

To move continuously, press and hold down the key or key com-
bination. The document scrolls as necessary.
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Scrolling with the
keyboard

Selecting text with
the keyboard

Scrolling

To scroll Press

Down or up one windowful = PAGE DOWN or PAGE UP

To the beginning or end of  CTRL-HOME Or CTRL-END
the document

To the next or previous GOTO-PAGE DOWN Or GOTO-PAGE UP
page (The GOTO key is the 5 on the
keypad.)

To scroll continuously, press and hold down the key or key
combination.

For more information on printed pages, see “Paginating” in
Chapter 5, “Printing a Document.”

Selecting Text

To select text, hold down the SHIFT key while holding down any
key combination that scrolls or moves the insertion point. The
SHIFT key indicates that you want to highlight the text as you
move over it. For example:

To select Press

Characters SHIFT-LEFT Or SHIFT-RIGHT

Words SHIFT-CTRL-LEFT Of SHIFT-CTRL-RIGHT
Lines SHIFT-UP Or SHIFT-DOWN

Now Try This

Practice moving the insertion point, scrolling, and selecting text
in the real estate listing you typed.

B Press and hold down a DIRECTION key to move the insertion
point continuously.

B Press the HOME or END key to move the insertion point to the
beginning or end of a line.

B Press GOTO-LEFT to move to the previous sentence, and press
GOTO-RIGHT to move to the next sentence.

B Press CTRL-HOME or CTRL-END to move the insertion point to the
beginning or end of the document.

B Press PAGE DOWN to scroll down to the next windowful, and
press PAGE UP to scroll back up.
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B Press and hold down the SHIFT-DIRECTION keys to select some
text.

Scrolling and Selecting with the Mouse

This section shows you how to move the insertion point, scroll a
document, and select text with the mouse.

Moving the Insertion Point

To move the insertion point to a new position on the screen: Moving the insertion

point with the mouse
Position the mouse pointer and click the mouse button.

Scrolling
To scroll with the mouse, use the scroll bars on the bottom and Scrolling with the
right side of the Write window, as shown in Figure 2.3. mouse

Vertical scroll box| 2 3 Using Scroll Bars
Click an arrow to scroll line by line. To scroll continuously,
point to an arrow and hold down the mouse button.

Vertical scroll bar

Urite - (Untitled)
Search  Character  Paragraph

File  Edit Docutent

area, $70,000. Classic ofd woitd charmer, 2 bedrooms pius master bedroam, fireplace, hardwood
floors, unfinished basement. All anpnam:es and drapes included. Private lotin good location,
close to schools and freeway. Call Jin Murphy at 999-7777.%

Horizontal Click above or below the scroll box
scroll box to scroll window by window.
Horizontal scroll bar Drag the scroll box to go to an

approximate place in the document.
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Selecting Text
To select Do this
Selecting text with Any text Point to where you want to begin select-

the mouse

Using the selection
bar

2.4 The Selection Bar

ing text and press the mouse button.
Drag over the text you want to select.
Release the mouse button.

Words Point to a word and double click to
select it. Hold the second click and drag
to extend the selection a word at a time.

Between points Point to the starting place for the selec-
tion and click. Move the insertion point
to a stopping place, hold down the SHIFT
key, and click.

Selecting with the Selection Bar The far left edge of the win-
dow is called the selection bar. In the selection bar, the mouse
pointer changes to an arrow that slants to the right. The selection
bar provides some additional options for selecting text.

Mouse pointer in selection bar

E3 ] firite - (Untitled)
| File Edit  Search  Character  Paragraph  Document

Just isted this week - a house that has 1o be seen to be believed? Call now! Richmond Beach
area, $70,000. Classic old world charmer, 2 bedrooms plus master bedraom, fireplace, hardwood

floars, unfinished basement. [A1 appliances and drapes included. Private Iot in good location,
J close to schools and freeway. Call Jim Murphy at 999-7777.X
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To select Do this

By the line Move to the selection bar and point to a
line. Click to select the line. Drag to
select more than one line.

By the paragraph Move to the selection bar and point to a
paragraph. Double click to select the
paragraph. Hold the second click and
drag to extend the selection a paragraph
at a time.

Between points Use the selection bar to select a line or
paragraph. Move to another line or para-
graph on the selection bar, press the SHIFT
key, and click. Write selects all lines or
paragraphs between the two points.

The entire document  Move to the selection bar, press the CTRL
key, and click.

Now Try This

Practice moving the insertion point, scrolling, and selecting text
with the mouse in the real estate listing you typed.

B Position the mouse pointer anywhere in the document and
click the mouse button to move the insertion point there.

B Click below the scroll box on the vertical scroll bar to scroll
down to the next windowful, and click above the scroll box to
scroll back up.

B Position the mouse pointer anywhere in the document and
press and drag over some text to select it.

B Position the mouse pointer in the selection bar and press and
drag to select some lines.

Going to a Specific Page Going to a specific
age

You can also scroll to a specific page number with the Go To pag

Page command. The Go To Page command only works when you

have divided the document into pages. You divide a document

into pages by printing it or by choosing the Repaginate command

from the File Menu. For more information on paginating, see

Chapter 5, “Printing a Document.”
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2.5 Go To Page
Dialog Box

To go to a specific page:

[ Choose Go To Page from the Search Menu, or press the F4 key.
You will see this dialog box:

Page Number: 1]

&) Canee)

(21 Type the page number that you want to go to.
B8] Choose the Ok button to carry out the command.

Deleting text

Deleting Text

There are five ways to delete text with Windows Write:

B With the BACKSPACE key

B With SHIFT-BACKSPACE

® With the DELETE key

B With the Cut command

B By typing over text you have selected

To delete Do ONE of these

One character Place the insertion point to the
right of the character and press
the BACKSPACE key.

Place the insertion point to the
left of the character and press
SHIFT-BACKSPACE.

More than one character Select the text, then choose
Cut or press the DELETE key.

Select the text, then start typ-
ing. The selected text is de-
leted and the text you type is
inserted in its place.



When you delete a selection with the Cut command or the DELETE
key, you remove the text from the document and put it on the
Clipboard.

Using the Clipboard

The Clipboard holds information that you delete or copy from
applications running with Windows. While text is on the Clip-
board, you can paste it elsewhere in your Write document. You
can also paste the contents of the Clipboard into another Write
document or into another Windows application.

When you put information on the Clipboard, it stays there until
you choose Cut or Copy again. Pasting the information from the
Clipboard into a document or other application does not remove
the contents of the Clipboard. You can also use the Clipboard to
move or copy graphics and text into your Write document from
other Windows applications. For more information, see Chapter 4,
“Pasting from Other Applications.” For more information on past-
ing text from the Clipboard, see “Inserting Text” and “Moving and
Copying Text” later in this chapter.

If you wish, you can expand the Clipboard to see its contents. To
do so, run CLIPBRD.EXE from the MS-DOS Executive window. See
the Microsoft Windows User’s Guide for more information.

Now Try This
Delete sentences from the real estate listing.

[1] Select the first two sentences in the paragraph, as shown
below.

[2] Choose Cut from the Edit Menu, or press the DELETE key, the
shortcut key for the Cut command.

Choose Cut to delete the selected text, or press the DELETE key.

Write - (Untitled)
File Edit Search Character  Paragraph  Document

Deleting Text 21

Using the Clipboard

Just listed this week -- a house that has 10 be seen to be believed!! Call now! [0 [z
area, $70,000. Classic old world charmer, 2 bedrooms plus master bedroon, fireplace, hardwood

ﬂOOI‘S unfinished basement. All appﬂances and drapes included. Private lot in good location,
close fo schools and freeway. Call Jim Murphy at §99-7777.X

2.6 Deleting Selected Text
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Inserting text by
typing

Inserting text from the
Clipboard

Inserting Text

There are two ways that you can insert text in your document:

B By typing the text
® By inserting text from the Clipboard.

To insert text by typing:

(i Move the insertion point to where you want to insert the text.
2] Type the text.

The text to the right of the insertion point moves over as you
type the new text.

To insert text from the Clipboard:

(il Move the insertion point to where you want to insert the text.

(2] Choose Paste from the Edit Menu, or press the INSERT key, the
shortcut key for the Paste command.

For more information on the Clipboard, see the sections “Deleting
Text” and “Moving and Copying Text” in this chapter.

For information on inserting graphics into your document, see
Chapter 4, “Pasting from Other Applications.”

Now Try This
Insert text in the real estate listing,

[ Position the insertion point before the period (.) following
“basement”.
[2] Press the SPACEBAR, then type with washer and dryer

[38] To insert text at the end of the document, position the inser-
tion point before the end mark. Press the SPACEBAR and type
Closing costs negotiable.

~
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Inserted text 2.7 Inserted Text

Urite - (Untitled)
facter\ P,

Richmond Beach area, $70,000. Classic old world charmer, 2 bedrooms plus master bedroom,
fireplace, hardwood fioors, unfinisfed basementwith washer and dryer, All appliances and
drapes included. Private ot in ggd location, close to schools and freeway. Call Jim Murphy at
999-7777. Closing costs negotiable, X

Moving and Copying Text

Moving text means that you delete it from its original location in
a document and insert it at a new location. Copying text means
that you take a copy of some text without deleting the original
text, and insert it at another location. Both actions use the Clip-
board to hold the text while you move or copy it.

You can move or copy text:

® Within a document
B Between Write documents
w\ B Between Write and other WIN applications

Moving Text Moving text
To move text:

Select the text.

Choose Cut from the Edit Menu, or press the DELETE key, the
shortcut key for the Cut command.

Position the insertion point where you want to move the text.

Choose Paste from the Edit Menu, or press the INSERT key, the
shortcut key for the Paste command.

Bl B E
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2.8 Deleting Text to the
Clipboard

2.9 Pasting Text from the
Clipboard

Copying text

Now Try This

Move a sentence from one part of the real estate listing to another
as follows:

i1 Select the text as shown.

Choose Cut to delete the selected text to the Clipboard.

trite - kUnntled

T Y Classic oid world charter, ZDeﬂmomspmsmastemuroom.

fireplace, hardwood floors, llllfﬂﬁﬂlﬂl basement with wasner and dryer. Al aopnances and
drapes included. Private lotin good ocation, close to schools and freeway. Call Jim Murphy at
999-7777. Closing costs negotiablet

2l Choose Cut from the Edit Menu.
[38] Move the insertion point to just before the end mark.
[a Choose Paste from the Edit Menu.

With the Paste command, you inserted
this text from the Clipboard.

Urite - (Untitled)
Character  Paragraph  Document
el ZDedIoomspmsmaslemedroom.ﬂremace floors,
: tmmwastmam:dryef Aﬂapphaneesanﬂdrapesmemm Prwatetotm

goodlocalmn, clgse to schools and freeway. Call Jim Murphy at 999-7777. Closing casts
negotiable. Richmond Beach area, $70,000.

Copying Text
To copy text:

(1] Select the text.

[2] Choose Copy from the Edit Menu, or press the F2 key, the
shortcut key for the Copy command.

[3] Position the insertion point where you want to insert the text.
[a] Choose Paste from the Edit Menu, or press the INSERT key.

Repeat steps 3 and 4 to make additional copies of the text.



Note A copy of the text remains on the Clipboard until the next
time you choose the Cut or Copy command. The Clipboard holds
only the text from the most recent Cut or Copy command. If you
cut or copy again before you insert, your original text will be lost
from the Clipboard.

Moving and Copying with the Mouse

If you have a mouse, you can use the following shortcut methods
for moving and copying text.

To move text with the mouse:

(1] Select the text you want to move.
[2] Point to where you want to insert the text.
(3] Hold down the SHIFT and ALT keys.
[a] Click the mouse button.
Write cuts the selected text and inserts it at the new location.

To copy text with the mouse:

(4] Select the text you want to copy.

(2] Point to where you want to copy the text.
(3] Hold down the ALT key.

(4] Click the mouse button.

Write copies the selected text and inserts it at the new
location.

Moving and Copying Between Write Documents

You can move and copy text from one document to another. The

procedures are similar to moving and copying within a document.

To move text between documents:

Select the text you want to move.
Choose Cut from the Edit Menu, or press the DELETE key.
Open the document you want to move the text to.

Place the insertion point where you want to insert the text in
the new document.

Choose Paste from the Edit Menu, or press the INSERT key.

Bl & R E
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Moving text with the
mouse

Copying text with the
mouse

Moving text between
documents
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Copying text between
documents

Finding text

To copy text between documents:

[ Select the text you want to copy.
(21 Choose Copy from the Edit Menu, or press the F2 key.
(81 Open the document you want to copy the text to.

(4] Place the insertion point where you want to insert the text in
the new document.

(8] Choose Paste from the Edit Menu, or press the INSERT key.

Note After you cut or copy text from a Write window to the
Clipboard, do not close the Write window. If you close the win-
dow, the formatting for the text on the Clipboard will be lost.

You can also paste text and graphics from other applications into
your Write documents. For more information, see Chapter 4,
“Pasting from Other Applications.”

Finding and Changing Text

You can easily locate text and change it with the commands in
the Search Menu. You can:

B Search for text up to 255 characters in length.
® Change all occurrences of the text in a document.
B Change only those occurrences you want to.

Finding Text

Use the Find command to look for a character, word, or group of
characters or words. The Find command starts at the insertion
point or at the end of the selection and goes to the end of the
document. Then Find goes back to the beginning of the document
and continues searching to the insertion point or to the end of
the selection.
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To find text:

6 ‘ [1 Choose Find from the Search Menu.
You will see this dialog box:

Type the text you want to find. 2.10 Find Dialog Box

Find Yhat: [ ' |

I,'rluhole Hord Match Upper/Lowercase
Find foxg

Check to match capitalization exactly. Otherwise,
Write finds, for example, “Main” and “main.”

Check to find separate occurrences only. Otherwise,

Write finds, for example, “main” in “‘remainder.”

[2] Choose the Find Next button to start the search, or press the
ENTER key.

there is one. If there are no occurrences of the text in the docu-

6@\ Write searches for the text and selects the first occurrence, if
ment, you see an alert box saying “Search text not found.”

To continue the search after an occurrence is selected:

Choose the Find Next button again.

When all occurrences of the search text have been found, you see
an alert that says “Search complete.”

You can search for text using a question mark (?) to match any
single character. For example, if the search text is hea?, you might
find “head,” “heal,” “heap,” “hear,” or “heat.”
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Editing between finds

You can search for text that includes spaces, tabs, paragraph
marks, and page breaks. Enter these special characters in the
search text:

Enter To stand for

N

w White space. Searches for any
combination of spaces, tab
characters, paragraph marks,
and page breaks.

“t Tab character.
p Paragraph mark.
°d Page break.

Note You can also use the above characters (except for “w)
when you find and change text with the Change command. For
more information, see “Changing Text” later in this chapter.

When you are finished finding text, close the Find dialog box.
To close the Find dialog box:

Press the ESC key, or choose Close from the System Menu on
the Find dialog box.

Editing Between Finds

Often you want to edit the document after you find each occur-
rence of the search text. This is best accomplished by closing the
Find dialog box after finding the first occurrence, and then using
the Repeat Last Find command.

With the Repeat Last Find command, you can continue searching
for text with or without the Find dialog box on the screen. The
Repeat Last Find command finds the next occurrence of the
search text used in the last Find command. The shortcut key for
the Repeat Last Find command is the F3 key. You can search
quickly through a document by pressing the F3 key repeatedly.

To edit between finds:

[ Use the Find command to find the first occurrence of the
search text.

(2] Close the Find dialog box.
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(3] Edit the document.

[4] Choose Repeat Last Find from the Search Menu, or press the F3
key.

Repeat steps 3 and 4 to continue finding and editing.

Note You can also use the Repeat Last Find command after first
choosing the Change command. For more information about the
Change command, see “Changing Text” below.

Changing Text

Use the Change command to find text and replace it with some- Finding and changing
thing else, or to change all occurrences of the text automatically.  text automatically

The Change command searches forward from the insertion point,
then goes to the beginning of the document and comes back to
the insertion point. However, if you select one or more characters
before choosing the Change command, the command operates
only within that selection.

To find and change text:

[1] Choose Change from the Search Menu.
You will see this dialog box:

Type the text you want to find.
Type the replacement text.

2.11 Change Dialog Box

Find Uhat: | ' ]
Change To: | |
[ 1%hole Hord [1Match Upper/Lowercase

[Find Next] (Change, thep Find) (Change] ( Change 4EL )

Select to find separate
occurrences only.

Select to match capitalization exactly.

[2] Choose one of the buttons to start: Find Next; Change, then
Find; Change; or Change All
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2.12 Change Dialog Box
Buttons

Find Yhat: [you |

Change To: [the seller |
Cthole Hord [ Match Upper/Lovercase

lFind Next| (Change, (then Find) (Change) (| Change All )

Changes all occurrences inthe
document automatically

Changes the selection
Changes the text, then finds the next occurrence
Finds the next occurrence of the search text

If there are no occurrences of the text in the document, you see
the alert “Search text not found.”

When the entire document has been searched, you see the mes-
sage “Search complete.”

When you are finished changing text, close the Change dialog
box.

To close the Change dialog box:

Press the ESC key, or choose Close from the System Menu on
the Change dialog box.

Often you want to make changes in part of a document rather
than the entire document. To do this, select part of the document
before you choose the Change command. The Change command
then operates only within the selection, and the Change All but-
ton becomes the Change Selection button.

To change text within a selection:

[1] Select the part of the document in which you want to find and
change text.

Choose Change from the Search Menu.
Fill in the Find What and Change To text boxes.
Choose a button to start.

The Change Selection button changes all occurrences of the
search text found within the selection.

Bl & B
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Now Try This

Open the document called PRACTICE.DOC that comes on your
Write disk. This is a longer document that is good for practicing
your find and change skills. If you currently have the real estate
listing or other document open, save that document before you
open PRACTICE.DOC.

Choose the Save command to save the current document. If the
current document is the real estate listing, save it with the name
HOUSE.

(1] Choose the Open command and open the document
PRACTICE.DOC.

[2] Choose Change from the Search Menu.

[38] Type you in the Find What box.

[a] Type the seller in the Change To box.

[5] Choose each of the buttons in turn to see what happens.
Find Next: finds the first occurrence of “you.”

Change, then Find: changes the first occurrence of “you” to
“the seller,” then finds the next occurrence of “you.”

Change: changes that occurrence of “you” to “the seller.”

Change All: changes the remaining occurrences of “you” to
“the seller.”

[6] Press the EsC key to close the Change dialog box.

Undoing Your Last Action Undoing your last
action

You can use the Undo command from the Edit Menu to reverse

your most recent action.

When you open the Edit Menu, the Undo command names
the most recent action: Undo Typing, Undo Editing, or Undo
Formatting.

To undo:

Choose Undo from the Edit Menu.

If your most recent action was undo, the Undo command reverses
the undo, so you have plenty of opportunity to change your mind.
Using the Undo command, you can switch back and forth between
two versions of text to see which you prefer.



3 Formatting Your Work

Formatting is the process of giving your document the appearance
you want. You can change the appearance of the characters, the
spacing and alignment of lines in each paragraph, and the page
layout for the entire document. Most of the formats you choose
appear on your screen as they will appear in the printed docu-
ment.

In this chapter:

B Formatting characters
B Formatting paragraphs
B Formatting documents

33
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3.1 Character Menu

Formatting Characters

The commands in the Character Menu control the style, position,
font, and font size of characters in your document.

Normal displays text Character style commands
without character| Character position
formatting. commands

" File Edit  Search Paragraph  Docunent

—Nornal F3

PREPARING A HOME FOR
Bold Fé
vitalic F

PREPARING AHOMEFORY Underline  F§
Superscript }/
Subscript

V1, Helv
PREPARNGAHOMEFORS#]| 2. Courier

PREPARING AHOME FOR SALE Reduce Font F9 \
Enlarge Font F10

EREPARING A HOME FOH | Fonts. ...

A checkmark indicates a Font and font size
format that applies to the commands. The available
selection. fonts vary depending on
the current printer and the
fonts you install.

On the screen, Write displays character formats that resemble
the formats you will see when you print the document. If your
printer cannot print a format, such as italic, Write does not dis-
play it. However, the selection still has the format, as indicated
by a checkmark on the menu. If you change to a printer that
prints the format, Write changes the display. See “Changing the
Printer” in Chapter 5, “Printing a Document,” for information on
how to change the printer.

Write saves character formats when you save your document.
Write also keeps character formats when you move or copy your
formatted text to other parts of the document or to another Write
document.
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When you type text, it will have the same formats as the text just
before the insertion point unless you change the format right
before you start typing.

Changing Character Styles Changing character

styles
Character styles add emphasis to text by making it bold, italic, or

underlined. You can apply more than one character style to the
same characters. For example, if you choose Bold, then Italic, then
Underline for the same selection, all three styles apply.

To change or add character styles:

[i] Select the text you want to change.

[2] Choose the style you want from the Character Menu, or press
a shortcut key as shown below.

To choose Press
Normal F5
Bold F6
Italic F7
Underline F8

If you choose a style that is already checked, Write removes that
style from the selection. For example, if Bold is already checked,
choosing Bold again cancels it.

Creating Superscripts and Subscripts Creating superscripts

and subscripts
Superscripts and subscripts are characters that appear slightly

above or below the rest of the text. They are also scaled to a
smaller size. Use them for notations such as H O or 64".

To create a superscript or subscript:

[1] Select the text you want to be a superscript or subscript.
[2] Choose Superscript or Subscript from the Character Menu.
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3.2 Superscript and
Subscript Examples

Changing fonts with
the Character Menu

Subscript

Urite - FORMAT

File Edit Search Character  Paragraph  Docunment
Amino acids contain the anino group N
One billicn can be written as 10
M
Superscript
Fonts

The font is the design of the alphabet in which text is displayed
or printed.

On the screen, Write displays the fonts and sizes that closely
resemble the output you will obtain with the current printer. The
design of the alphabet may not match exactly, but the line breaks
and page breaks are accurate.

Changing Fonts and Size with the Character Menu

The Character Menu contains the names of the fonts that you can
assign to text in your document, and commands to reduce or
enlarge the fonts. Up to three font names are displayed on the
menu itself, and more may be displayed in the Fonts command
dialog box. The font names you see depend on the current
printer. For more information on fonts and the current printer,
see the Appendix, “Fonts and the Current Printer.”

Changing Fonts When you start typing text in a new docu-
ment, Write uses the default font for the current printer. If you
want to change to a different font, you can choose one of the
font names displayed in the Character Menu.

To change fonts:

[ Select the text you want to change.
[2] Choose one of the font names from the Character Menu.
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=N i PRA 00 3.3 Fonts on the
File  Edit  Search : Paragraph _ Document Character Menu
Mury Normal B kaltors
11950 16th | gorg  Hle, WA 98112
Italic.
PREPARING A HOME FOR 5AL L
Superscript
You can understand that showiny  Subscript makes the buyer want 10

purchase quickly and at a bettef
and early sale.

Fix up nside. Badly faded whls
you add a freshlook. Clean ging

tips t set the stage for a profitable
V1, Helv o ageforap

2, Courier .
[Ppeal. Selective painting will help
create a bright, cheery appearance.

. N Reduce Font F9
Make minor repairs. Dripping fa g |plumbing. You should make sure ai
plumbing is in good working prd Enlarge Font FLO em,s.qcﬁttcalprosnectcan

concentrate on major considp ral Fonts II sticking drawers or doors can
distract the buyer as weil. —

Fonts available with the current printer

There may be more than three fonts available for the current
printer. You can change to a font that is not displayed on the
Character Menu with the Fonts command. For more information,
see “Changing Fonts and Size with the Fonts Command” later in
this chapter.

Changing Font Size You can change the font size with the Changing font size
Reduce Font and Enlarge Font commands from the Character with the Character
Menu. Menu

To change the font size:

[1] Select the text you want to change.

[2] Choose Reduce Font or Enlarge Font from the Character
Menu. Or, press the shortcut key F9 (Reduce Font) or F10
(Enlarge Font).
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8-point Helv
12-point Helv
10-point Helv

3.4 Font Size Examples

=] lrite - FORMAT [ |

File Edit  Search  Character  Paragraph  Document

Preparing a Home for Sale

Preparing a Home for Sale
Preparing aHome for Sale

Preparing a Home for Sale

Preparing a Home for Sale

Preparing a Home for Sale

X

8-point Courier
12-point Courier
10-point Courier

The current printer
is Epson FX-80.

When you choose Reduce Font, Write changes the font size

to the next smaller size. When you choose Enlarge Font, Write
changes the font size to the next larger size. The sizes are deter-
mined by Write, independent of the current printer. If you change
to a font size that the current printer does not support, the text
on the screen does not change size. If you change to a font size
that the current printer does support, you see the size change

on the screen.

To find out the current size of some text:

[ Select the text.
[2] Choose Fonts from the Character menu.

The dialog box displays the current font size in the Size text box.

Font sizes are given in points. A font size of 10 points gives about
6 lines of text to the inch when printed.
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Changing Fonts and Size with the Fonts Command Changing fonts and
size with the Fonts
With the Fonts command you can change to a font that is not command

displayed on the Character Menu. When you choose the Fonts
command, you see a dialog box that lists all the fonts available for
the current printer. If you want to select a font that is not on the
list, you can add the font name to the list.

To change fonts or font size with the Fonts command:

[ Select the text you want to change.
[2] Choose Fonts from the Character Menu.
You will see this dialog box:

Select a font name in the list box.
Write proposes the font used
in the current selection.

These sizes are recommended 3.5 Fonts Dialog Box

for the selected font.

rite -

FORHA
]

Preparing a Home for Sale

Preparing a Homne for 9 Font Nane:

Preparing a Home f

Preparing a Hg

Preparing a Home for

|

Select a font size or...

...type a font size.
Write displays the current font size.

[38] Choose the Ok button to carry out the command.

If you enter a font size that cannot be printed on the current

printer, Write does not change the size of the text displayed on
the screen.
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Adding a font name
to the list

If the current selection has more than one font or font size
assigned, the Fonts dialog box does not propose a font name or
size. You can leave either of these items blank to indicate “no
change.” This is useful if you want to change the font size for a
selection that contains various fonts, or change the font name for
text that appears in various sizes.

As you assign fonts from the dialog box to your text, the font
names displayed on the Character Menu change to reflect the
fonts you use most often.

You can add a font name to the list in the Fonts dialog box and
then assign that font to text in your document. This is useful if
you plan to print the document on a printer other than the
current printer.

For example, perhaps the Epsone FX-80 is the only printer in-
stalled in your Windows system. But a co-worker uses Windows
with a NEC 3550, and you plan to print the document on that sys-
tem. You can add NEC 3550 font names to the Fonts dialog box
and assign them to text in your document. Then you can print the
document in the fonts you want on the NEC 3550. You can still
print the document on your Epson FX-80, or on another printer;
if the Spooler doesn’t recognize a font name, it selects an available
font and continues printing.

As an alternative, you could install the NEC 3550 (or any other
printer) in Windows using Windows Setup or the Control Panel.
Then you could change to that printer before you format the
document in Write. For more information, see “Changing the
Printer” in Chapter 5, “Printing a Document.”



To add a font name to the list:

(il Choose Fonts from the Character Menu.

Font Name text box

Write - FORMAT

Preparing a Home for Sale

Font Nate:
ourierjjii |

Preparing a Home for 9

Preparing aHome for Sele
A Courler
Preparing a Home f£{ [Hely

Freparing a Hc

Preparing a Home for

Font Size text box

2 Type the name of a font in the Font Name text box.
[3] Type the size of the font in the Font Size text box.
Choose the Ok button to carry out the command.

Formatting Paragraphs

The commands in the Paragraph Menu control the alignment,
spacing, and indents of lines in each paragraph.
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3.6 Font Name and Font
Size Text Boxes
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3.7 Paragraph Menu

Starting a new
paragraph

Normal restores left
alignment and single
spacing with no indents.

Paragraph alignment
Line spacing

Write - PRACTICE.DOC
Paragraph

Murphy & Allq Nornal

Centered

Right
PREPARING A HOME FOR SALE Justified

File Edit

You can understand that showing a home to its bej
purchase quickly and at abetter price. Here are s
and early sale.

Fixkip inside. Badly faded walls or worn wood
you add a fresh laok. Clean windows and unmarr

Make mmnr TEDEH'S I:mnpmg faucets call attention po faulty plun hihg. You should make sure all
plumbing is lngoodwmkmg order. If you can corregt small items, a ¢ ical prospect can

concentrate on major cansiderations. Loose door Knobs and sticking drawers or doors can
distract the buyer as well

Checkmarks indicate formats
for the paragraph containing
the insertion point.

Before choosing a command from the Paragraph Menu, position
the insertion point inside the paragraph you want to format. Or,
you can format more than one paragraph at a time. To do this,
make a selection that spans all the paragraphs you want to format.
The command affects all the paragraphs that are included in the
selection.

Starting a New Paragraph
To start a new paragraph:

[1] Position the insertion point where you want to start the para-
graph.
(2] Press the ENTER key.

If you want a blank line between paragraphs, press the ENTER
key twice.

Every time you press the ENTER key, Write inserts a paragraph
mark in the document and starts a new line. There is no visible
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character for the paragraph mark, so you cannot see it on the
screen. But you can select, delete, copy, and move a paragraph
mark just as you do other characters.

For example, in PRACTICE.DOC, the blank lines between para-
graphs were created by pressing the ENTER key twice: once to start
a new line and again to leave that line blank. So there are two
paragraph marks after each paragraph. You can select an individual
paragraph mark as you would select any single character. Or, you
can make a selection that includes text and paragraph marks.

Paragraph mark selected

3.8 Paragraph Marks

. . rite - PRACTICE.DOC
File Edit  Search | Character  Paragraph _ [Document
plumbing i in good working gfder. If you can correct smallitems, a critical prospect can

concentrate on major consjderations. Loose door knabs and sticking drawers or doors can
distract the buyer as well)

First impressions are important. You should keep the lawn trinmed and edged, cultivate flower
beds, and remove all refuse or clutter from the yard, sidewalk, and porches.

— Vo chonld nau cosnialationtion ta tha Vitshan wihan orgnarina thabnua éacsala. Shinina.__ __ __ |

Paragraph mark selected

Write - PRACTICE.DOC
Search  Character  Paragraph  Document
plumbing is in good warking order. If you can correct small tems, a critical prospect can

concentrate on major constderations. Loose door knobs and sticking drawers or doors can
distract the buyer as well.

First impressions are impartant. You should keep the lawn trinmed and edged, cultivate flower
beds, and remove all refuse o clutter from the yard, sidewalk, and porches.

— \lau choiddnaucaanialattantias tathalitabanashan inathabnuadacrada. Shines —

Paragraph marks included in selection

=] ] lrite - PRACTICE.DOC
File 3

Edit

Search

concentrate on major considerations. Loose door kno
distract the buyer as well.

First mpressions are important. You should keep the lawn trimmed and edged, cultivate flower
beds, and remove all refuse or clutter from the yard, sidiawalk, and porches.

pay special attention to the kitchen vhen preparing the honie for sale. Shining|§
avens, ranges, and appliances will catch the buyer's eye and make a good impression. Keeping the

cgumefs and sink cleared and neat makes the kitchen look spacious. Colorful curtains in harmony
L— uuth tha anuintar tancanddinars add annaalagwall . o . .
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Changing paragraph
alignment

When you copy or move a paragraph, include the paragraph mark
in the selection to keep the paragraph formats with the paragraph.

A new paragraph starts out with the same formats as the pre-
vious paragraph. For example, if you are typing a paragraph that
is double-spaced and justified and you press the ENTER key, the
following text you type will be double-spaced and justified.

To remove a paragraph break:

[1 Place the insertion point at the beginning of the paragraph
following the break you want to remove.

[2] Press the BACKSPACE key.

If your paragraphs have a blank line between them, press the
BACKSPACE key twice.

Changing Paragraph Alignment

You can align a paragraph on the left margin, the right margin,
or both margins (justified), or you can center it between the
margins.

To change paragraph alignment:
(1] Place the insertion point inside the paragraph you want to
change.

[2] Choose one of the alignment commands from the Paragraph
Menu: Left, Centered, Right, or Justified.
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The Left command aligns a The Centered command -
paragraph flush left on the centers each line in the :é.)?a;arlzgraph Alignment
margin. paragraph. P

=] ] Write - PRACTICE,DOC a1
File Edit  Search  Character  Paragraph  [Document

Fix up inside. Badly faded walls or worn woodwark reduce appeal. Selective painting wil help
you add a fresh look. Clean windows and unmarred walls wil create a bright, cheery appearance.

Make minor repairs. Dripping faucets call attention to faulty plumbing. You should make sure all

plumbing is in good working order. If you can correct small items‘ acnitical prospect can

concentrate on major considerations. Loose door knobs and sticking drawers or doors can
distract the buyer as well.

First impressions are important. You should keep the lawn trinmed and edged, cultivate flower
beds, and remove all refuse or clutter from the yard, sidewalk, and porches.

You should pay special attention to the kitchen when preparing the home for sale. Shining
ovens, ranges, and appliances will catch the buyer's eye and make a good impression. Keeping the
counters and sink cleared and neat makes the kitchen look spacious. Colorful curtains in harmony
with the counter tops and floors add appeal as well

Bathrooms that sparkle can be a real plus. You should check and double-check them.

The Justified command The Right command aligns a
adjusts spaces so text fills the paragraph flush right on the
line to both margins. margin.

Changing Paragraph Line Spacing Changing paragraph
line spacing

You can change the line spacing in a paragraph to single spacing,

1 1/2 spacing, or double spacing.

To change line spacing:
(1] Place the insertion point inside the paragraph you want to
change.

[2] Choose one of the line spacing commands from the Paragraph
Menu: Single Space, 1 1/2 Space, or Double Space.
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: 12 space
3.10 Paragraph Spacing . 7nc31 between lines
Examples
E o PRA D
File  Edit  Search  Character JELENEIIED Docurent
Normal 4
Make minor repairs. Dripping faucets call attentio) | oo, lou should make sure 2l
plumbingis in good working order. If you can Centered prospect can ;
concentrate on major considerations. Loose doo Wers or doars can

aht
distract the buyer as well Justified

First impressions are important. You shoud keep \,i";%ess”m Esged.unﬁvaleﬂower
beds, and remove all refuse or clutter from the var| Double g;g:e .

You should pay special attention to the kitchenwil_Indents...  biorsale. Shining

g
=4
=
g
é.
w
[
a
g
2
:
1
§.
g
g
E.
g
g
o
=
Z
£
g
=

Single space Double space
Ys inch between lines s inch between lines

Changing paragraph  Changing Paragraph Indents

indents
You can indent a paragraph from the left or right margin, and you
can indent the first line of a paragraph. Note that indenting is not
the same as moving the margin itself. To change the margins for
the printed page, see “Changing the Page Layout” later in this
chapter.



To change paragraph indents:

[ Place the insertion point inside the paragraph you want to
change.

[2] Choose Indents from the Paragraph Menu.
You will see this dialog box:

Type a measurement to indicate the indent
you want. The first line indent is relative to
the left indent. Measurements are in inches.

Incents

Left Indent: [N /] | )
First Line: [0 4] (o)
Right Indent:[@" | =

[3] Type a measurement in inches for any indent you want to
change.

Choose the Ok button to carry out the command.

You can also create a hanging indent with the Indents command.
In a paragraph with a hanging indent, the first line extends farther
to the left than the rest of the paragraph.

To create a hanging indent:

[1] Place the insertion point inside the paragraph you want to
change.

[2] Choose Indents from the Paragraph Menu.

[3] Enter a positive number for the measurement of the left mar-
gin indent.

(4] Enter a negative number for the measurement of the first line
indent.
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3.11 Indents Dialog Box

Creating a hanging
indent
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3.12 Paragraphs with
Hanging Indent

Displaying or
hiding the Ruler

Docurent

Murphy & Allen, Realtors
11950 16th Ave. E., Seattle, WA 98112

pred Left Indent: %)

First Line: [1.3" | (CameL ) tecenakes th buyer wantto puchase
Right Indent:[@™ | - set the stage for a profitable and early

Fix up inside. Badly faded walls of worn woodwork reduce appeal. Selective painting wil
help you add a fresh look. Clean windows and unmarred walls wil create a
bright, cheery appearance.

Make minor repaifs. Dripping faucets cal attention to fauity plumbing. You should make sure al
plumbing is in good working order. If you can correct small items, a critical
DfOSpEGt can cuncentrate on mamr Wﬂs‘ﬂﬁ alums I.OOSQ door RIIODS and

Hanging indent
[s] Choose the Ok button to carry out the command.

Formatting Paragraphs with the Ruler

If you have a mouse, you can also change paragraph formats with
the Ruler. The Ruler appears at the top of the window when you
choose the Ruler On command from the Document Menu.

To display the Ruler:

Choose Ruler On from the Document Menu.

To hide the Ruler:

Choose Ruler Off from the Document Menu.



Left indent marker and first
line indent marker (one on
top of the other)

Line spacing icons
Alignment icons

lrite - PRACTICE.DOC

0 BEE BEEE

mlnnl T

logK. Clean windows and unmarred walls will cre te abright, cheery appearance.

irs. Oripping faucets cal attention to faulty plukbing.| You should make sure all
Wworking order. If you can correct smallems, a eritical prospectean | _ ki

Decimal tab icon Right indent marker

Left-align tab icon Ruler|

To change paragraph alignment with the Ruler:

(1] Place the insertion point in the paragraph you want to change.
[2] Click one of the paragraph alignment icons above the Ruler.

To change line spacing with the Ruler:

(1] Place the insertion point in the paragraph you want to change.
[2] Click one of the line spacing icons above the Ruler.

To change indents with the Ruler:

(1] Place the insertion point in the paragraph you want to change.
[2] Drag one of the indent markers to a new position.

Note that the left indent marker and the first line indent marker
are superimposed before you move one of them.

Left indent marker
First line indent marker

Urite - PRACTICE.DOC
Character  Paragraph _ Document

-~ BEE IIII

G120 Boaa 1|

you add a 'I'ESII look. Clean windows and unmarred walls will create a bright, cheery appearance.

Make mmor Tepairs. DI’IDDIIIQ faucets call attention to faulty plumbing. You should
make sure all pmmhmg IS in gocd workmg order.|if you can correct small items, a critical prospect
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3.13 The Ruler

Changing alignment
with the Ruler

Changing line spacing
with the Ruler

Changing indents
with the Ruler

3.14 First Line and Left
Indent Markers
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3.15 Document Menu

The indents you create with the Ruler are reflected in the Indents
dialog box.

You can also change tab settings with the Ruler. For more infor-
mation, see “Setting Tabs with the Ruler” later in this chapter.

Formatting a Document

The commands in the Document Menu control formats that apply
to the document as a whole.

Add headers, footers,
and page numbers

Murphy & Allen, Realt

11950 16th Ave. E., Seattle,|!Footer...

Ruler On
PREPARING A HOME FOR SALE Tabs. ..
You can understand that showing a home fo ts best advantage makk—age Layout..
purchase quickly and at a better price. Here are same tested tips 10 set the stage for a profitable

and early sate.

Fix up inside. Badly faded walls or worn woodwork reduce appegl. Selective painting will kelp
you add a freshlook. Clean windows and unmarred walls will create a bright, cheery appearance.

Make mingr repairs. Dripping faucets call attention to faulty pluibing. You should make sure 2l
plumbing s in good working order. If you can correct small items, a critical prospect can

concentrate on major considerations. Loose door knobs and stigking drawers or doorscan
distract tnelwyefasweﬂl 1

Pagel e I s

Change margins on the
printed page
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When you start a new document, the formats are automatically set
as follows:

Header: 0.75 inch from top of page, aligned at left margin.
Paragraphs: single-spaced, left-aligned, no
indent. Left-align tabs every 0.5 inch.

3.16 Preset Formats

Footer: 0.75 inch from bottom
of page, aligned at left margin.
Margins: 1-inch top and bottom, 1.25-inch
left and right. Text can be indented
from the left and right margins.

Headers and Footers

A header is text that appears at the top of every page, and a footer
is text that appears at the bottom of every page. Use the Header
or Footer command from the Document Menu to:

B Enter the text you want for the header or footer.
B Include page numbers in the printed document.
B Include the header or footer on the first page.

B Change the distance between the header or footer and the top
or bottom of the page.
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Adding a Header or
Footer

3.17 Header Document
and Dialog Box

You do not see headers and footers in the document until you
print the document. You can have one header and one footer in
each document.

Adding a Header or Footer
To add a header or footer:

[1] Choose Header or Footer from the Document Menu.

You will see the Header or Footer document and the Header
or Footer dialog box:

Type header text here. Press ALT-TAB to switch between the header
document and the header dialog box.

Header document

\File Edit  Search | Character Docutient
M

Paragraph

Distance from Top:
(Insert Page #)] (Clear) | Return to Document |

O Print on First Page

Deletes the header

(21 Type the text for the header or footer in the Header or Footer
document.

You can format the text as you would any other text.

[8] Press ALT-TAB to select the Header or Footer dialog box, or
click the mouse inside the dialog box.



(4]

Type a measurement in the Distance from Top box if you want
to change the distance between the header and the edge of
the page.

For a footer, this measurement is Distance from Bottom.

Select the Print on First Page check box if you want the
header or footer to appear on the first page of the printed
document.

Otherwise, Write does not print the header or footer on the
first page.

Choose the Insert Page # button to have page numbers in the
printed document.

When you choose the Insert Page # button, Write inserts the
special text “(page)” at the insertion point in the Header or
Footer document. The special text becomes consecutive page
numbers when you print your document.

To carry out the command and return to your document,
press the ESC key at any time, or choose the Return to Docu-
ment button in the Header or Footer dialog box.

Note Pressing the ESC key or choosing the Return to Document
button saves the text, formatting, and editing you entered in the
Header or Footer document. You cannot use the ESC key in a
Header or Footer document to erase all your changes. You can,
however, use the Undo command in the Header or Footer docu-
ment as you would in any document.

Adding Page Numbers Only

To add page numbers only:

6

(2]
(8l

Choose Header from the Document Menu if you want page
numbers printed at the top of the page; choose Footer if you
want them at the bottom.

Move the insertion point to where you want the page number
to appear on the line.

Press ALT-TAB to activate the Header or Footer dialog box,
or click the mouse inside the dialog box.

Choose the Insert Page # button. This button inserts the
special text “(page)” in the Header or Footer document.
The special text becomes consecutive page numbers on

the printed page.

Choose the Return to Document button to carry out the
command.

Formatting a Document 53

Adding page numbers
only
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Aligning a header or
footer

Aligning a Header or Footer

Normally, Write aligns the header and footer with the left margin
on the printed page. You may want your header or footer aligned
with the right margin or in the center of the page. You can
change the alignment of a header or footer just as you would
change the alignment of any other paragraph.

To change the alignment of a header or footer:

0]
(2

Position the insertion point inside the header or footer text.
Choose Left, Right, or Centered from the Paragraph Menu.

Now Try This

Add a header to PRACTICE.DOC, and format it so that it appears
centered, 0.75 inch from the top of each page except the first

page.
(1l Open PRACTICE.DOC. Choose Header from the Document

PEE & BN

&l

Menu.
Choose Centered from the Paragraph Menu.
Now the text you type will be centered as you type it.

Type Preparing a Home for Sale in the Header document and
press the ENTER key.

Type Page and press the SPACEBAR.
Press ALT-TAB to select the Header dialog box.

Press the TAB key twice so the blinking underscore is in the
Insert Page # button.

Press the SPACEBAR.

Write inserts the special text “(page)” at the insertion point in
the Header document.
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Special text “(page)” is inserted when

you choose the Insert Page # button. 3.18 Header Example

Page Header

O Print on First Page
(Clear) | |

=
Distance from Top:

(‘Insert Page #)

Press SHIFT-ALT-TAB to select the Header document again.

[8] Press the ENTER key twice to leave a blank line between the
header and the text when you print the document.

fid Press the ESC key to save the header and return to
PRACTICE.DOC.

Try printing PRACTICE.DOC so you can see the header on each
page.

Setting Tabs Setting tabs

You can easily set tabs for lists or tables with Write. Use the Tabs
command from the Document Menu, or use the Ruler. A tab can
be a left-align tab or a decimal tab. Use left-align tabs to form

a column of items aligned on the left. Use decimal tabs to form

a column of numbers aligned on their decimal points.

Tabs are preset at every half inch. The preset tabs are left-align
tabs. They do not appear in the Tabs dialog box or on the Ruler.
Tabs that you set override the preset tabs. You can set up to

12 tabs.
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3.19 Tabs Dialog Box

Decimal tabs

To set tabs:

[1] Choose Tabs from the Document Menu.
You will see this dialog box:

Type a position for each tab you want. The number you
type represents inches from the left margin.

Positions:[ ' [ ' | | | | |
Decimal: [J. !I. o g. g 0.
|

Positions: | ] | ] | |
Decival: [@D. O. O. O. O. 0O

(K| ] (Cameel ) (Clear nu\]\

Select a check box to set Choose this button to
a decimal tab. Otherwise, restore preset tabs.
tabs are left-align.

[2] To change a tab, select the position and type a number in
inches.

(8] To delete a tab, select the position and press the DELETE key.
To delete all tabs at once, choose the Clear All button.
(4] Choose the Ok button to carry out the command.

The tabs you set with the Tabs command are reflected on the
Ruler.

Decimal Tabs

A decimal tab is a special tab stop that aligns text on the decimal
point. When you type text at a decimal tab stop, the characters
you type are inserted to the left of the tab stop until you type a
decimal point. The decimal point is inserted at the tab stop, and
any additional characters you type are inserted to the right of the
decimal point. If you don’t type a decimal point at a decimal tab,
all the text you type will be right-aligned at the tab stop. Thus,
you can use a decimal tab as a right-align tab if you want to.
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Setting Tabs with the Ruler Setting tabs with the
Ruler

If you have a mouse, you can also set tabs with the Ruler. The

Ruler appears at the top of the window when you choose the

Ruler On command from the Document Menu.

To set tabs with the Ruler:

[i] Choose Ruler On from the Document Menu.

Left-align tab icon 3.20 Tab Settings on the
Decimal tab icon (selected) Ruler
Decimal tab marker

te - FORMAT
ter  Paragraph  Document

E

M P T | PP AT A | TR A

Berylium 9012
Bisuth 208980

Use the horizontal scroll bar to scroll the Ruler.
Left-align tab marker

[2] Click the tab icon you want to use: left-align or decimal.

[3] Click the Ruler where you want to set a tab, or drag an exist-
ing tab marker to a new position.

[4] To hide the Ruler, choose Ruler Off from the Document Menu.

The tabs you set with the Ruler are reflected in the Tabs dialog
box.
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Changing the page
layout

3.21 Page Layout
Dialog Box

To remove a tab with the Ruler:

Drag the tab marker down and off the Ruler.

Changing the Page Layout

The page layout is the arrangement of text on the page when you
print your document. Use the Page Layout command to:
B Change Write’s margins for the printed page.

B Specify a starting page number other than 1 for the printed
document.

In a printed document, indented text is indented from the mar-
gins you set with the Page Layout command.

To change the page layout:

[l Choose Page Layout from the Document Menu.
You will see this dialog box:

Type the starting page number.

Start Page Nusbers at: [l T | (k)
Hargins: L

[ Lefe: Right:
{Top: Bottom: [I"__ ]

In the Margins boxes, enter measurements to change the
margins on the printed page. Measurements are in inches.

[2] In the Start Page Numbers At box, type the number at which
you want page numbers to start, if different than 1.

(8] In the Margins boxes, type the margins you want.

Choose the Ok button to carry out the command.

If you enter a starting page number, Write adjusts the page num-
bers displayed in the lower-left corner of the window. Write also
uses the adjusted page numbers for the Go To Page command
from the Search Menu.



4 Pasting from
Other Applications

You can paste text and graphics from other Windows applications
into your Write documents. Pasting makes it easy to enhance
documents visually and to insert text without retyping it.

In this chapter:

® The Clipboard

B Four examples of pasting information into Write
B Moving and sizing a picture in Write

B Pasting from Write into other applications

® Using Write with Microsoft Word

59
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You can paste information from any application that runs with
Windows, whether it is a WIN application or a standard applica-
tion. For general guidelines about running standard applications,
see Chapter 9, “Techniques for Standard Applications,” in the
Microsoft Windows User’s Guide. In particular, the section
“Transferring Information” tells you how to move and copy
information between Windows applications.

Note If you have a computer with 512K of memory or less, you
will probably run only one application at a time. You can still
paste from another application into Write; it is not necessary to
run the two applications simultaneously. Windows holds the infor-
mation you copy and paste on the Clipboard. Windows saves the
Clipboard even after you quit the application you copied from.

The Clipboard

The Clipboard

The Clipboard holds the information you want to paste. You have
probably already used the Clipboard to move and copy text
within a Write document.

You can run the Clipboard any time during a Windows session to
see what is on it. This is useful if you want to check the contents
of the Clipboard before you paste.

To run the Clipboard:

(i1l Open the MS-DOS Executive window.
(2] Select and run CLIPBRD.EXE.



Choose Copy in Write to copy
the selection to the Clipboard.

File  Edit  Search
Paragraph  Document

WRITE Formatted Text, Text Character

Fixup inside. Badly faded walls or worn woodwd,
90|.| add a fresh look. Clean windows and unma

PREPARING A HOME FOR SALE

You can understand that SIIOWI]IQ ahome toits
gcm and at a better price. Here are some te
]

Fix up inside. Eadly faded walls or worn woodw
0U add a fresh look. Clean windows and unmar

Make IMIIOI' Tepairs. Dnnpmg faucets call attent
plumbing is in good working order. If you can co
concenrate on major considerations. Loose do
distract the buyer as well

First impressions are important. You should kee
beds, and remove all refuse or clutter from the y

Run CLIPBRD.EXE to view the contents of the Clipboard.

The Clipboard contains the most recent information you cut or
copied from a Windows application. The next Paste command
pastes this information into an application. The contents of the
Clipboard remain until you cut or copy new information, or end
the Windows session. The following examples show how to paste
different kinds of data from various applications into Write. The
examples are:

B Pasting graphics from Windows Paint (a WIN application).
B Pasting spreadsheet data from Microsoft Multiplane (a standard
application that runs in a window).

® Pasting a chart from Lotuse 1-2-3e (a standard application that
does not run in a window).

B Pasting text from Microsoft Access (a standard application that
does not run in a window).

This is a small sampling of the applications you can paste from.
To paste from other applications, follow the example that comes
closest to your situation.

The Clipboard 61

4.1 Viewing the Clipboard
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Pasting graphics from Pasting Graphics from Windows Paint
Windows Paint

Windows Paint is a drawing tool that is a WIN application; that is,
it was designed especially to run with Microsoft Windows. You
can paste all or part of a Paint canvas into a Write document.

To paste from Paint:

(1 Open a Paint window with the canvas you want to copy from.

[2] Pick up the Selection Rectangle tool, and select the area of the
canvas you want to paste into Write.

4.2 Selection Rectangle in Selection Rectangle tool Selection rectangle
Paint

=] Paint - HIRAGANA.DOC
File Edit Font [ FontSize Style Palette

B Choose Copy from the Edit Menu.
This copies the selection to the Clipboard.

[a] Open a Write window with the document you want to paste
into.

[8] Move the insertion point to where you want to insert the
graphics from Paint.
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When you choose the Paste command, the graphics will be inserted

from the Clipboard at the insertion point. 4.3 Pasting at the

Insertion Point

rite - KANA.DOC
Character  Paragraph  Document
hgana (phonetic), Katakana (phonetic for foreign words,

Bracters used for their sounds, like our alphabet. Thus, the
ed in hiragana by its three syilables:

Have Picture .
Rize Picture katakana is written in the block style, and X

(6] Choose Paste from the Edit Menu to insert the graphics into
the document.
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4.4 Graphics Pasted from
the Clipboard

trite - KANA.DOC
File  Edit  Search  Character  Paragraph  Document
Japanese has three writing systems: hiragana (phonetic), Katakana (phonetic far fereign words,
and Kaji ("Chinese” characters). ) ]
Hiragana and katakana consist of characters used for their sounds, like our aiphabet. Thus, the
Japanese word /abefe (ea) is represented in hiragana by its three syliables:

Hiraganais written in the cursive style, and katakana is written in the block style, andj
Page 1 4] | a0 i 200001

Graphics pasted from the Clipboard

Note Choosing Paste need not be your first action after opening
the document. But it is wise to paste immediately, before you
choose the Cut or Copy command and inadvertently change the
contents of the Clipboard.

You can also use Paint to enhance text or graphics from other
applications before pasting into Write. See “Pasting from Write
into Another Application” later in this chapter.

Pasting data from
Microsoft Multiplan

Pasting Data from Microsoft Multiplan

Multiplan runs with Windows as a standard application in a win-
dow. You can use the System Menu to mark the area you want
to paste.

To paste from Multiplan:

(1] Open a Multiplan window with the worksheet you want
to paste from.

[2] Choose Mark from the System Menu.

[3] Select the area you want to copy, as shown in Figure 4.5.
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Use the pIRECTION keys to move to the beginning of the selection. 4.5 Selecting Part of

Multiplan Worksheet

WD OO0 IO LI L5 GO == (D WD

1
COMMAND: FLE Blank Copy Delete Edit Fornat Goto Helﬂ.lnsm Lock Move

ane Options Prin 3u1t Sort Transfer Value Hindow Xternal
Select opgion oOr type comman .

letter

Use sHIFT-DIRECTION to selectan area. Withthe
mouse, drag overthe area you want to select.

[a] Choose Copy from the System Menu.

This copies the selection to the Clipboard.
[5] Choose the Multiplan Quit command to close the application.

[6] Open a Write window with the document you want to paste
into.

Move the insertion point to where you want to insert the data.

If your document is in a proportional-space font such as Hely,
it’s a good idea to change to a fixed-space font such as Courier
before pasting spreadsheet data. This assures that your columns
of figures will line up in your Write document.
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4.6 Before Pasting
Multiplan Data

4.7 After Pasting Multiplan
Data

trite - SALESL
File Edit Search  Character  Paragraph  Document
and the figures reflect this quite clearly.
A quick summary o the national sales figures shows that we are continuing with this trend; |
k

Choose Paste from the Edit Menu to insert the data into the
document.

If you changed to a fixed-space font, change back to the
proportional-space font before you continue typing.

Data pasted from Multiplan is in Courier.

File Edit Search  Character  Paragraph  Document |

and the figures reflect this quite clearly.

A quick summary of the national sales figures shows that we are continuing with this trend:
Sales hy Region (1,000's)

Region 1983 1984

\ North 103 106

The rest of the document is in Helv.




Pasting a Chart from Lotus 1-2-3 67

Pasting a Chart from Lotus 1-2-3 Pasting a chart from
Lotus 1-2-3

You can run Lotus 1-2-3 as a standard application with Windows.

It does not run in a window, so you will not use the System Menu

to mark or copy a selection. Instead, you will copy the entire

screen to the Clipboard by pressing ALT-PRINTSCREEN.

To copy a chart from Lotus 1-2-3 to the Clipboard:

(1] Start Lotus 1-2-3 from the MS-DOS Executive and open the
chart you want to copy.

Press ALT-PRINTSCREEN to copy the screen to the Clipboard. 4.8 Copying a Lotus 1-2-3

Chart to the Clipboard

[2] Press ALT-PRINTSCREEN to copy the screen to the Clipboard.

[3] Choose the Quit command in Lotus 1-2-3 to close the
application.

In Lotus 1-2-3, the chart is drawn in white on a black field. The
image of the chart that is on the Clipboard is black on a white

field, because Windows inverts graphic images when you copy
them with ALT-PRINTSCREEN.
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4.9 Lotus 1-2-3 Chart
Pasted into Write

To paste the chart into Write:

l Open a Write document and move the insertion point to
where you want to insert the chart.

[2] Choose Paste from the Edit Menu to insert the chart.

= Write - EMPLOYEE b
File Edit Search Character  Paragraph  Document

Number of Employees

228
208
188
168

Note The chart will be the same size it was in Lotus 1-2-3. Do
not size this chart as you would size other pictures in Write. The
large area copied from the Lotus 1-2-3 screen makes sizing the
chart difficult in Write.

Pasting text from
Microsoft Access

Pasting Text from Microsoft Access

Microsoft Access is a communications program used to connect to
information services and electronic mail services. Because Access
runs with Windows, you can paste information you receive from
these services into your Write documents.

Perhaps you subscribe to Dow Jones News/Retrievale or
CompuServes Information Service. If you are writing a memo
based on news received from a service, you could paste the news
screen right into your document. Or, you could paste some elec-
tronic mail you received from a co-worker.
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To paste information from Microsoft Access:

(1] Start Access from the MS-DOS Executive and log on to the
mail or information service you want to use.

4.10 Copying Electronic

Electronic mail message*
Mail to the Clipboard

e | h

From:  Marke
Subgect: Pensonnel Report
To: Andreal

Thanks for the fine personnel report on the Al{ha,
Beta, and Delta {roaect teams, You and ?our staff
are to be congratulated for their careful handling
of H‘nese projects, especially during the last six

months,

The report itself is exemplary, | am forwarding
copies to the following people:

Fran Fielding, Consor\ate_ Accounting
George Constance, Actuaria] (ffice i
Rokert Mondragen, Southuest Regional 0ffice
Sandy Finch, Vice President, Finance

Thanks again, and congratulations,

|
SESSION Access: ERM  0@:14:17 Lt

\.

Press ALT-PRINTSCREEN to copy
the screen to the Clipboard.

Microsoft Access, running
with Windows

[2] When the information you want to paste is on the screen,
press ALT-PRINTSCREEN to copy the text to the Clipboard.

[3] Log off the service and choose Quit to close Access.

[4] Open a Write document and move the insertion point to
where you want to insert the information.

[8] Choose Paste to insert the information.

If the information contains text you don’t want in your document,
you can edit or delete it just as you would any other text.
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4.11 Electronic Mail
Pasted into Write

Electronic mail message pasted
into Write document

File  Edit  Search  Character [ Paragraph  Document

Thereport itself is exemplary. | am forwar ding
capies to the following peaple:

Fran Fielding, Corporate Accountmg

George Constange, Actuarial Office

Robert Mondragon, Southwest Regional Office
Sandy Finch, Vice President, Finance

Thanks again, and congratulations.
MC

{
SESSION Access: ERM  00:06:25 L1wWiK

Delete any pasted text you
don’t want in your document.

Moving and Sizing a Picture in Write

After you paste a picture or graph into Write, you can select it
and move, copy, or paste it just as you would text.

The picture is always pasted into the document at the left margin.
You can move the picture horizontally with the Move Picture
command. You can change the size of the picture with the Size
Picture command. The Move Picture and Size Picture commands
are active while a picture is selected.

Moving a Picture

You can move a picture horizontally with the Move Picture com-
mand from the Edit Menu. You can move the picture with the
keyboard or the mouse.
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With the Keyboard

To move a picture with the keyboard: Moving a picture with

the keyboard
[11 Move the insertion point to the left of the picture and press

SHIFT-RIGHT to select the picture.
[2] Choose Move Picture from the Edit Menu.

An icon appears in the center of the picture and a dotted
frame surrounds the picture.

Use the RiGHT and LEFT keys to move the

picture frame. Then press the ENTER key. 4.12 Using DIRECTION Keys

to Move a Picture

rite - KANA.DOC
Parara h Docunent

amkam] “Chines )
Hiragana and katakana consist of characters used for their sounds, llkeouralpnabet Thus, the
Japanese word e(eatllsrepresenteﬂmmragmawmm“svn

[3] Press the RIGHT or LEFT direction key to move the dotted
frame.

[4] When the frame is where you want it, press the ENTER key.
Or, press the ESC key to leave it where it was.
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Moving a picture with
the mouse

Sizing a picture with
the keyboard

With the Mouse
To move a picture with the mouse:

(1 Click the picture to select it.
[2] Choose Move Picture from the Edit Menu.

An icon appears in the center of the picture and a dotted
frame surrounds the picture.

(8] Without pressing the mouse button, move the mouse right or
left to move the dotted frame.

(4] When the frame is where you want it, click the mouse button.
Or, press the ESC key to leave it where it was.

Sizing a Picture

You can enlarge or reduce a picture in Write with the Size Picture
command from the Edit Menu. You can size the picture with the
keyboard or the mouse.

With the Keyboard
To size a picture with the keyboard:

(1] Move the insertion point to the left of the picture and press
SHIFT-RIGHT to select the picture.

[2] Choose Size Picture from the Edit Menu.

An icon appears in the center of the picture and a dotted
frame surrounds the picture.



Moving and Sizing a Picture in Write 73

Usethe LEFT, RIGHT, or DOWN keys to
movetothe edge ofthe frame. To size
in two dimensions, move to a corner.

4.13 Using DIRECTION Keys
to Size a Picture

birite - KANA.DOC
Paragraph

Documnt

and kanji (“Chinese” character S)
Hiragana and katakana consist of gharacters used for their sounds, like our alphabet. Thus, the
Japanese word fabefe (eat) is represented in hiragana by its three syllabies

’: ta

Hiragana is written in the cursive style, and katakana is written in the block style, and X

Use the pirecTION keys to size the picture.

5 [3] Press the LEFT, RIGHT, or DOWN key to move the icon to the
bottom or side of the dotted frame. To size in two dimensions,
move the icon to a lower corner of the dotted frame.

[4] Press a DIRECTION key to enlarge or reduce the frame.

For example, if the icon is in the lower-right corner, pressing
the up key reduces the height of the dotted frame, and pressing
the LEFT key reduces the width.

(5] When the frame is the size you want, press the ENTER key.
Or, press the ESC key to go back to the original size.

With the Mouse

To size a picture with the mouse: Sizing a picture with

the mouse
(1] Click the picture to select it.

[2] Choose Size Picture from the Edit Menu.

An icon appears in the center of the picture and a dotted
frame surrounds the picture.
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(8] Without pressing the mouse button, move the icon to the bot-
tom, left, or right edge of the frame.

At the edge of the frame, move the icon in the direction you
want to enlarge or reduce the picture.

(4] When the frame is the size you want, click the mouse button.
Or, press the ESC key to go back to the original size.

Pasting from
Write into another
application

4.14 Text Selected in
Write Document

Pasting from Write into
Another Application

You can paste text and graphics from your Write documents into
other applications. The following example shows you how to
paste text into Paint. You may want to do this to make certain
text, such as a title or letterhead, more elaborate. Then you can
paste the text back into your Write document.

To paste from Write into Paint:

0l Open two windows on the screen: a Write window with a
document and a Paint window with a clean canvas.

[2] Select the text in the Write document that you want to paste
into Paint.

Copy text to the Clipboard.

rite - RAIN.D

ile it Search
Paragraph  Document

WHITE RAIN WINDOW WASHERS

Dear Customer,
Summer is here again, and our rates are the same

If you've got to be inside, you might as well have
acallif you would like to renew your contract.

and guarantee our work. Plus, you can't beat ou
Hope to hear fram you soon,

White Raink
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[38] Choose Copy from the Edit Menu.
Select the Paint window.
[6] Choose Paste from the Edit Menu.

Text pasted into Paint

4.1‘5 Text Pasted into

Urite - RAIN,DOC Paint

File  Edit  Search  Character
Paragraph  Document

WHITE RAIN WINDOW WASHERS

Dear Customer,

Summer is here again, and our rates are the sam
I you've got to be inside, you might as well hav
acallif you would like to renew your contract.
and guarantee our work. Plus, you can't beat o
Hope to hear from you soon,

White RainX

AUAITERANVIRITW\OAEFERS

---------------- "

Now you can use the Paint tools to make the text really exciting.
Use your imagination and experiment. If you want to start over,
erase the canvas and paste the text again.

When you finish designing the text, you can paste it back into
the Write document. See “Pasting Graphics from Windows Paint”
earlier in this chapter for instructions.
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4.16 Text Graphics
Pasted Back into Write

Graphics from Paint pasted back into document

trite - RAIN,DOC
Search  Character  Paragraph

[
FHDEH)

WASHERS

File  Edif Docunent

Dear Customer,
Summer is here again, and our rates are the same as last year!
If you've got to be inside, you might as well have a good view. So give us

acallif you would like to renew your cantract. We value your patronage
and guarantee our work. Plus, you can't beat our prices.

Using Write with Microsoft Word

Write is highly compatible with Microsoft’s in-depth word pro-
cessing program, Word. You can share documents between these
two writing programs and get the benefits of both.

Microsoft Word is a word processor for people who handle long
documents or need advanced capabilities. With Word, you get
special features such as mail merge, spelling checker, footnotes,
glossaries, style sheets, and automatic hyphenation.

Write offers the advantages of combined text and graphics and the
ability to paste information from other applications. It is the per-
fect writing program for busy people who need to get short docu-
ments out quickly. Write is also very easy to learn because it uses
the standard Windows interface.

If you are using both Write and Word, or if you have access to
Write and Word documents, you will find the two products com-
plement each other. You can move a Write document into Word
and use advanced features, such as mail merge, with that docu-
ment. You can move a Word document into Write and paste in
graphics and text from Paint and other applications in Windows.
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Both word processors are very flexible in their treatment of fonts,
but they do not use the same fonts. A document transferred into
Write can use only the fonts available with Write. A document
transferred into Word can use only the fonts available with Word.

Using a Word Document in Write Using a Word

document in Write
To use a Word document in Write, open the document with the

Open command in Write. You can begin immediately to edit the
text, paste graphics from the Clipboard, or perform other Write
tasks with the document.

Because Word has more ways to treat text than Write does, some
aspects of the document will change. Check the list below to see
how Write will handle your Word document.

® If the Word document has more than one division, Write uses
only the division formats of the first division. Write discards
automatic page numbers, but keeps the starting page number,
if you specified it. Write does not acknowledge any margin set-
tings made in the Word document; instead it uses the margins
that are set for the current printer in Write. Write changes
Word’s division marks into page breaks and discards any divi-
sion formats assigned after the first division.

B If the first division of the Word document has a header and if
the header is the first paragraph in the document, it becomes
the header in the Write document. The same is true for the
footer (or for both, if they are the first two paragraphs).
Headers and footers that are not the first two paragraphs
are discarded. Headers and footers from later divisions are
discarded.

Note If you are using Version 1.0 of Microsoft Word, Write
discards all headers and footers.

B Write displays footnotes from the Word document as para-
graphs at the end of the document. Write displays automatic
footnote references as asterisks. If you entered your own foot-
note references in Word, Write retains them.

B Write uses the tab settings from the first paragraph of the
Word document. These tab settings apply to the entire Write
document.

B Write keeps the paragraph formats from Word, except extra
space between paragraphs. If paragraphs have line spacing
greater than double spacing (such as triple spacing), Write
changes it to double spacing.
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B Write keeps new-line characters.
B Write keeps the bold, italic, and underline character formats.

Write discards the strikethrough, double underline, and upper
case formats and displays the text as normal text. Write dis-
plays a smaller font for small caps, but does not capitalize the
text. Write keeps superscripts and subscripts.

Write changes nonbreaking spaces to “§” and nonbreaking
hyphens to “4.” Write discards optional and automatic
hyphens.

Write discards formatting that was done with Word style
sheets. If you want to keep the formatting, change style sheet
formatting to direct formatting before you transfer the docu-
ment to Write.

To change style sheet formatting to direct formatting:

Al
(2]
(3]

(4]

Bl &

Select the entire document in Word.
Press ESC, F, C to open the Format Character menu.

Choose a character format that was NOT used in your docu-
ment, such as Strikethrough or Double Underline, and choose
No for that format.

Press the ENTER key.
This converts the character formatting done with style sheets
to direct formatting. When you apply direct formatting to all

the characters, Write breaks its connection with the character
formats on the style sheet.

Press ESC, F, P to open the Format Paragraph menu.

Choose a paragraph format that was NOT used in your docu-
ment, such as Keep Follow, and choose No for that format.

Press the ENTER key.

This converts the paragraph formatting done with style sheets
to direct formatting. When you apply direct formatting to all
the paragraphs, Write breaks its connection with the paragraph
formats on the style sheet.

Save the document.

Now you can transfer the document to Write without losing the
formatting.
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Using a Write Document in Word Using a Write
document in Word

To use a Write document in Word, open the document as you
would open any document with Word. You can begin immedi-
ately to use all the features of Word with the document.

Word keeps the character, paragraph, and document formats you
assigned to the Write document. If you add Word-only features,
such as footnotes or divisions, these will be changed if you open
the document again with Write. See the above section, “Using a
Word Document in Write.”

Note If your Write document contains graphics, delete them
before transferring the document to Word. If you do open a docu-
ment with graphics in Word, do not attempt to edit the graphics
or print the document with Word. The Word program is not
intended for use with graphics.




5 Printing a Document

When you are ready to print a document, use the Print command
from the File Menu to send the document to the printer. If you
want to see where Write will break the pages before you print,
use the Repaginate command to paginate the document. Write
also has a Change Printer command that lets you switch to a dif-
ferent printer before you start printing,

In this chapter:

B Using the Print command
B Paginating

B Changing the printer

81
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Printing a document

5.1 Print Dialog Box

Using the Print Command

When you print 2 document, you can specify the number of
copies and the range of pages you want to print. Write proposes
printing one copy of the entire document. If you want to change
the preset margins before you print the document, use the Page
Layout command. For more information, see “Changing the Page
Layout” in Chapter 3, “Formatting Your Work.”

To print a document:

[ Choose Print from the File Menu.
You will see this dialog box:

If the current printer has a draft mode, you will see this option. Select
the check box if you want to print the document in draft mode.

To print more than one copy, type the number of copies here.

[ Draft Quality

Page Range:
®All
( Fron:|

| To:|

To print a range of pages, select this option and type the
page numbers in the From box and the To box.

[2] Select the options you want in the dialog box.
8] Choose the Ok button.
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You will see this message:

5.2 Printing Message

Murphy & Allen, Realtors
11950 16th Ave. E., Seattle, WA 98112

best advantage makes the buyer want to
some tested tips to set the stage for a profitable

prk reduce appeal. Selective painting will kelp
ed walls will create a bright, cheery appearance.

Make mingr repairs, Dripping faucets call attention to fauity plumbing. You should make sure all
ptmnbmglsmgooq g order. if you can correct small items, a critical prospect can
concentrate on considerations. Loose door knobs and sticking drawers or doors can
distract the buyer

Choose this button to cancel printing.
Printing a document starts the Spooler.

To pause or cancel the print job after Write has sent the docu- Pausing or canceling
ment to the printer, you use the Controls Menu in the Spooler. printing

To pause or cancel printing:

(] Expand the Spooler icon.

You will see a dialog box with a listing of the jobs in the print
queue.

(2] Select the name of the document you want to pause or cancel.
(8] Choose Pause or Terminate from the Controls Menu.

To resume printing after a pause, choose Resume from the
Controls Menu.

For more information, see Chapter 8, “Using the Spooler,” in the
Microsoft Windows User’s Guide.
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Inserting a page
break

5.3 Inserting a Page
Break

Paginating a
document

Paginating

Paginating is the process of breaking a document into pages. Write N
paginates a document for you automatically when you print it.

Write controls pagination so that a single line in a paragraph is

not printed by itself at the top or bottom of a page.

If you know you want a new page to start at a specific place, you
can insert a page break.

To insert a page break:

] Position the insertion point where you want the page break
to occur.

[2] Press CTRL-ENTER.

Press CTRL-ENTER to insert a page break here.

rite - PRACTICE.DOC
Character  Paragraph

File Edit  Search
distract the buyer as well

Firstimpressions are inportant. You should keep the Jawn trimmed and edged, cuitivate flower
beds, and remove allrefuse or clutter from the yard, sidewalk, and porches.

You should pay special attention to the kitchen when preparing the home for sale, Shining i
ovens, ranges, and appliances will catcn the Duyﬂ 3 eye and make agood impression. Keeping the w
- wmwm MW ARNOL. )

Docuwent

You can use the Repaginate command on the File Menu to
paginate a document. Then you can preview the page breaks
on the screen before you print the document. The Repaginate
command has an option called Confirm Page Breaks. It lets you
approve or move each page break Write proposes during
pagination.

After pagination, two arrows (> ) in the left margin indicate the
first new line of each page. The page breaks that you move or
insert yourself show as a dotted line across the document, fol-
lowed by the two arrows. The dotted line can be selected,
deleted, or copied just like any other character.



A dotted line indicates an inserted page break.

trite - PRACTICE.DOC

Search _ Character  Paragraph
distract the buyer|as well

First impressions are important. You should keep the Jawn trimmed and edged, cultivate flower
beds, and remove all refuse or clutter from the yard, sidewalk, and porches.

Docurent

|

You should pay special attention to the kitchen when preparing the home for sale. Shining

ovens, ranges, and appliances will catch the buyer's eye and make a good impression. Keeping the
OOIIIIIEI'S and sink cleared and neat makes the kitchen look spacious. Colorful curtains in harmony
with the counter tops and floors add appeal as well

Bathrooms that sparkle can be areal plus. You should check and double-check them.

Bedrgsgr&s areimportant focal points. You will find it worth the effort to keep them neatly
arran

%é:ts look larger when clothes are properly hung and shoes, hats, and other artictes are allin

To paginate a document:

[ Choose Repaginate from the File Menu.
You will see this dialog box:

Select the check box if you want to
approve each page break during pagination.

Repaginate Document

[2] Select the Confirm Page Breaks check box if you want to
approve each page break during pagination.

[8] Choose the Ok button.

Paginating 85

5.4 Page Break

5.5 Repaginate
Dialog Box
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5.6 Confirming Page
Breaks

If you elected to confirm page breaks, you will see this dialog box
at each page break:

Write proposes to break the page here.

Irite - PRACTICE.DO
Paragraph  Document

You should pay special attention to the kitchen when preparing the home for sale. Shining
ovens, ranges. and appliances will catch the buyer's eye and make a good impression. Keeping the

| Use up and down buttons -
| to move page break (__ln ) [Confirm ] puble-check them.

if necessary,
then confirn, [ Doun ) ( Cancel )

[t to keep them neatly

Note You cannot move a page break down from where Write
proposes it. If you do not like the page break, you must move it
up. Use the Down button if you move the page break up too far
and want to move it back.

The Repaginate command does not change a page break you
inserted with CTRL-ENTER. However, while you are confirming page
breaks, Write stops at each page break you have inserted and asks
if you want to keep or remove it.

After a document has been paginated, you can jump to a specific
page with the Go To Page command from the Search Menu. This
is a quick way to scroll through a long document once it has been
paginated. See “Going to a Specific Page” in Chapter 2, “Editing a
Document.”
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Changing the Printer

Write prints your documents on the current printer. The current
printer is the printer you installed in Windows. If you have
installed more than one printer, you can change to a different
printer in Write with the Change Printer command. The printer
you change to then becomes the current printer.

The Change Printer command lists all the printers you installed
in Windows during setup and with the Add New Printer command
in the Control Panel.

You can change printers in order to print on a different printer, or
just to format your document for a different printer. The printer
you change to need not be physically connected to your com-
puter, but it must be installed in Windows.

When you change printers, the appearance of your document

may change on the screen. This is because Write applies the fonts
and character formats available with the current printer. These
changes may affect the line breaks and page breaks in the docu-
ment. If you change printers and want to see the new page breaks,
use the Repaginate command.

To change the printer:

[1 Choose Change Printer from the File Menu.

You will see a dialog box with a list of the installed printers.
[2] Select the name of the printer you want to change to.
B Choose the Ok button.

If the new printer has options for the mode of operation, you will
see another dialog box. Select the options you want to use with
the printer and choose the Ok button.

Changing the printer



6 Command Summary

Write commands help you create, edit, format, and print your
documents. You choose commands from the menus on the menu
bar at the top of the Write window.

In this chapter:

® Choosing commands with the keyboard
8 Choosing commands with the mouse
B Shortcut command keys

B Descriptions of all the commands, in the order they appear on
the menus
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Choosing commands
with the keyboard

Choosing Commands with the Keyboard

There are several keyboard techniques you can use to open
menus and choose commands. Use the techniques that you find
most convenient.

To choose a command:

[1] Press the ALT key and the first letter of a menu to open the
menu.
For example, pressing ALT-F opens the File Menu.

[2] Press the first letter of a command on the menu.

For example, pressing N chooses the New command on the
File Menu. If two commands have the same first letter, press
the letter twice to select the second command.

[3] Press the ENTER key to carry out the command.

If the command needs more information, you will see a dialog
box.

To close a menu without carrying out a command:

Press the ESC key.

To use a shortcut:
Here is a quicker way to carry out a command with the keyboard.

(@ Press and hold down the ALT key.

[2] Press a letter key to open a menu, but do not release the ALT
key.

(3] Press a letter key to select a command, and release both keys
to carry out the command.

This shortcut method is the same as selecting the command and
then pressing the ENTER key.

To go from menu to menu:

(1 Open any menu.
(2] Press the LEFT or RIGHT key to open the next menu.
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To choose a command from the System Menu:

(1] Press ALT-SPACEBAR to open the System Menu.
[2] Press the first letter of a command to select it.
(8] Press the ENTER key to carry out the command.

The shortcut method also works for the System Menu.

Choosing Commands with the Mouse Choosing commands
with the mouse

If your mouse has more than one mouse button, use only the left
button with Write.

To choose a command:

[ Point at a menu and press the mouse button.
(2] Drag the mouse to select the command you want.
(8] Release the mouse button to carry out the command.
If the command needs more information, you will see a dialog

box.
To choose a command from the System Menu:

(1] Point at the System Menu box and press the mouse button.
(2] Drag the mouse to select a command.
(3] Release the mouse button to carry out the command.

To close a window with the mouse:

Double click the System Menu box.

You can also close any dialog box that has a System Menu by
double clicking the System Menu box on the dialog box.
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Shortcut command
keys

6.1 Shortcut Keys on the

Edit Menu

Shortcut Command Keys

Some commands have shortcut keys. Pressing a shortcut key is the
same as choosing the command. For example, pressing the F2 key
carries out the Copy command from the Edit Menu. The shortcut
key names are displayed next to the commands on the menus.
Not all commands have shortcut keys, but the most commonly
used commands do.

Shortcut keys
indo $h/tse
Cut \Del
Copy F2
Paste Ins
Hove Picture
fize Picture

With shortcut keys, you bypass opening the menu and choosing
the command, and immediately carry out the command. You will
find shortcut keys convenient, whether you have a keyboard sys-
tem or a mouse system.

For this command Press this key
Undo SHIFT-ESC
Cut DELETE
Copy F2

Paste INSERT
Repeat Last Find F3

Go To Page F4
Normal (Character) F5

Bold F6

Italic F7
Underline F8
Reduce Font F9
Enlarge Font F10

B



The System Menu

The System Menu is common to all Windows applications and
contains commands for manipulating the windows themselves.
Display the System Menu by pressing ALT-SPACEBAR or by clicking
the System Menu box with the mouse.

Size

The Size command changes the size of a window. Choosing the
Size command displays a size icon on the screen. You move the
size icon with the DIRECTION keys or the mouse. You will see a
dotted line when you move the icon to the window border. Con-
tinue moving the icon until the dotted line conforms to the win-
dow size you want. Then carry out the command by pressing the
ENTER key or releasing the mouse button.

If you have a mouse, you can also change the size of a window
with one of the size boxes in the upper- or lower-right corner of
the Write window. Point to a size box and press the mouse but-
ton. Drag the size box past the window border, then drag until
the window is the size you want and release the mouse button.

Move

Use the Move command to move a window to another position
on the screen. You can also use the Move command to expand an
icon or shrink a window. The advantage of using the Move com-
mand to expand an icon is that you can position the new window
wherever you want.

When you select a window and choose Move, the icon for that
window appears in the middle of the window. Press the DIRECTION
keys to move the window in the direction you want. Each time
you press a DIRECTION key, the window icon moves to the nearest
window center or window border. Press the ENTER key to open
the window on the location you chose.

If you have a mouse, there are two ways to move a window. You
can choose the Move command and move the window icon with
the mouse. Then click the mouse button to open the window on
the location you choose.

Or, you can bypass the Move command by pointing to a window’s
title bar and pressing the mouse button. The mouse pointer
becomes the window icon and you can drag it to a new location.
Release the mouse button to open the window in the location
you choose.

You cannot move a zoomed window.

The System Menu 93
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lcon

Zoom

Close

New

Open

Ilcon

The Icon command shrinks the selected window into an icon and
places the icon in the icon area.

The Icon command also expands a selected icon into a window.
The Icon command automatically expands the icon as soon as you
carry out the command. The window opens in the column just
above where the icon was in the icon area.

Zoom

The Zoom command expands the selected window to full screen,
even if it was an icon. Choosing this command again unzooms the
window, that is, returns it to the original size and position.

Close

The Close command closes the application running in the selected
window and removes the program from memory. To use the pro-
gram again, you run it from the MS-DOS Executive window.

The File Menu

Use the File Menu commands to create, save, and print your Write
documents. Both the Open and New commands let you save any
changes to the current document before proceeding.

New

The New command clears the window and opens a new, untitled
document with the preset format and tabs. The document remains
untitled until you give it a name with the Save command. For
more information, see page 5.

Open

The Open command opens the document you select from the
Open list box. If there is a current document, Write closes it.

You can also open different directories and disk drives with the
Open command. Disk drives and directories are shown in square
brackets in the list box. If you open a disk drive, the list box
displays the documents and directories that are on the disk in that
drive. If you open a directory, the list box displays the documents
and subdirectories that are in that directory. For more informa-
tion, see pages 6-7.
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Save Save

The Save command saves the document on the current disk in the
current directory. If the document is untitled, you assign a name
with the Save command. You can also change the name with the
Save command.

You can save to a subdirectory by preceding the document name
with the subdirectory name, JOBS\ for example.

If you have a hard disk, you can save to a different disk by preced-
ing the document name with the drive name, B: for example.

The Save command has options for saving a backup copy and for
saving a document without formatting. For more information, see
pages 8-11.

Print Print

The Print command paginates the document and sends it to the
current printer. The Print command automatically runs the Win-
dows Spooler, and the Spooler icon appears on the screen. The
Print command has options for the number of copies you want

to print and for printing a selected page range. Write is preset to
print one copy of the entire document. The Print command is dis-
abled (gray) if you have not installed a printer using Windows
Setup or the Add New Printer command in the Control Panel. For
more information, see pages 82-83.

Change Printer Change Printer

The Change Printer command changes the current printer. You
select the printer you want from a list box. The list box has the
names of the printers you have installed in Windows. The appear-
ance of your document on the screen may change when you
choose Change Printer because Write always formats the docu-
ment for the current printer. For more information, see page 87.

Repaginate Repaginate

The Repaginate command paginates the document so you can pre-
view the page breaks before printing. Write indicates page breaks
by placing >> in the left margin. While Write is repaginating, you
can approve or change page breaks with the Confirm Page Breaks
option. For more information, see pages 84-86.
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Undo

Cut

Copy

Paste

Move Picture

The Edit Menu

The Cut and Copy commands in the Edit Menu are disabled
(gray) until you select some text. The Move Picture and Size Pic-
ture commands are disabled until you select a picture (graphics).

Undo

The Undo command reverses your most recent action. The com-
mand name changes, depending on your most recent action:
Undo Typing, Undo Formatting, or Undo Editing. If your most
recent action was undo, the command changes to Undo, and you
can use it to reverse the undo. For more information, see page 31.

Cut

The Cut command removes selected text or graphics from the
document and puts it in the Clipboard. Pressing the DELETE key is
the same as choosing Cut. For more information, see pages 20-21
and 23-24.

Copy

The Copy command copies selected text or graphics to the Clip-
board. Pressing the F2 key is the same as choosing Copy. For more
information, see pages 24-26.

Paste

The Paste command inserts the contents of the Clipboard at the
insertion point. Pressing the INSERT key is the same as choosing
Paste. The contents of the Clipboard can be from a Write docu-
ment or from another Windows application. For more information,
see pages 21-26 and Chapter 4, “Pasting from Other Applications.”

Move Picture

The Move Picture command puts a move icon in the selected pic-
ture and a dotted frame around the picture. Move the icon with
the LEFT and RIGHT keys or with the mouse until the dotted frame
is positioned where you want the picture. Then press the ENTER
key or click the mouse button to set the new position. Or, press
the ESC key to return to the original position. For more informa-
tion, see pages 70-72.
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Size Picture Size Picture

The Size Picture command puts a size icon in the selected picture
and a dotted frame around the picture. Use the DIRECTION keys or
the mouse to move the size icon to the edge of the dotted frame.
If you move to a corner, you can size in two dimensions. Move
the size icon until the dotted frame is the size you want the pic-
ture to be. Then press the ENTER key or click the mouse button to
set the new size. Or, press the ESC key to return to the original
size. For more information, see pages 72-74.

The Search Menu

The Find command starts searching for text at the insertion point
or at the end of the selection and goes to the end of the docu-
ment; then it goes to the beginning of the document and contin-
ues searching to the insertion point or to the end of the selection.
The Change command searches like the Find command. But,

if you have characters or words selected, Change searches only
within the selection.

You can use a question mark as a wildcard character in the
search. For example, hea? might find “head,” “heal,” and “heap.”

The Find and Change commands both have the Whole Word and
Match Upper/Lowercase options. Select the Whole Word check
box to assure that Write does not find the search text embedded
in other text, such as “main” in “remainder.” Select the Match
Upper/Lowercase check box to find only those occurrences with
the same capitalization as the search text. Otherwise, Write
ignores capitalization while searching.

Find Find

The Find command searches for a specific piece of text and
selects it. The Find dialog box stays on the screen while Write
searches. You can choose the Find Next button to continue
searching. To close the Find dialog box, press the Esc key. For
more information, see pages 26-28.

Repeat Last Find Repeat Last Find

The Repeat Last Find command continues the search for the text
from the last Find or Change command. You can continue the
search with Repeat Last Find even after you have closed the Find
or Change dialog box. Pressing the F3 key is the same as choosing
Repeat Last Find. For more information, see pages 28-29.
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Change

Go To Page

Normal

Change

The Change command searches for a specific piece of text and
selects and/or changes it. The Change dialog box stays on the
screen while Write searches. You can choose the Find Next but-
ton or the Change then Find button to continue searching and
changing. You can choose the Change All button to change all
occurrences of the text automatically. If you make a selection
before choosing the Change command, the command operates
only within the selection. To close the Change dialog box, press
the EsC key. For more information, see pages 29-31.

‘Go To Page

The Go To Page command scrolls to a specific page number.
Write assigns page numbers when you print the document or
paginate it with the Repaginate command. Pressing the F4 key
is the same as choosing Go To Page. For more information, see
pages 19-20.

The Character Menu

To change the appearance of characters, select them before
choosing a command from the Character Menu. If you do not
make a selection, the command applies to the next text you type.
Otherwise, the text you type has the character formats of the text
immediately preceding it.

Character formats do not appear on the screen if they are not sup-
ported by the current printer.

The formats assigned to the selected text have a checkmark by
them on the menu. Choosing a command that is already checked
unchecks it and removes the formatting.

For more information, see pages 34-41.

Normal

The Normal command removes all character formatting except
font and font size changes from your text. Pressing the F5 key is
the same as choosing Normal. For more information, see page 35.



Bold

The Bold command changes the character style to boldface. Press-
ing the F6 key is the same as choosing Bold. For more information,
see page 35.

ltalic

The Italic command changes the character style to italic. Pressing
the F7 key is the same as choosing Italic. For more information,
see page 35.

Underline

The Underline command underscores text. Pressing the F8 key
is the same as choosing Underline. For more information, see
page 35.

Superscript

The Superscript command raises characters above the baseline
of the text. The superscript appears in a smaller size. For more
information, see pages 35-36.

Subscript

The Subscript command lowers characters below the baseline of
the text. The subscript appears in a smaller size. For more infor-
mation, see pages 35-36.

Font Names

Up to three font names appear on the Character Menu, depending
on the current printer. Choose a font name to assign that font to
text. Write changes the names and their order on the menu
depending on the fonts you use most often. For more information,
see pages 36-37.

Reduce Font

The Reduce Font command reduces the size of a font to the next
smaller size. If a smaller size is not supported by the current
printer, there is no visible change on the screen. Pressing the F9
key is the same as choosing Reduce Font. For more information,
see pages 37-38.
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Enlarge Font

Fonts

Normal

Left

Right

Centered

Enlarge Font

The Enlarge Font command increases the size of a font to the next
larger size. If a larger size is not supported by the current printer,
there is no visible change on the screen. Pressing the F10 key is
the same as choosing Enlarge Font. For more information, see
pages 37-38.

Fonts

The Fonts command displays all the fonts and sizes available for
the current printer. You can select a font and size from the lists to
assign them to text. Or, you can enter a font name and size for a
different printer and assign them to text. For more information,
see pages 39-41.

The Paragraph Menu

The commands in the Paragraph Menu change the formats of a
paragraph that contains the insertion point, or of all of the para-
graphs in the current selection. When you start a new paragraph
by pressing the ENTER key, it begins with the same formats as the
preceding paragraph. For more information, see pages 41-50.

Normal
The Normal command restores the preset paragraph formats: left-

aligned, single-spaced, unjustified, with no indents. For more infor-
mation, see page 42.

Left

The Left command aligns the paragraph flush left on the margin.
For more information, see pages 44-45.

Right

The Right command aligns the paragraph flush right on the mar-
gin. For more information, see pages 44-45.

Centered

The Centered command centers each line of the paragraph inside
the current margins. For more information, see pages 44-45.



Justified

The Justified command justifies the paragraph. It fills in the spaces
between words to align the paragraph on the left and right mar-
gins. For more information, see pages 44-45.

Single Space

The Single Space command sets the line spacing with one-sixth
inch between lines. If the line includes different font sizes, the
line spacing will vary to accommodate the tallest character in the
line. For more information, see pages 45-46.

1 1/2 Space

The 1 1/2 Space command sets the line spacing with one-quarter
inch between lines. For more information, see pages 45-46.

Double Space

The Double Space command sets the line spacing with one-third
inch between lines. For more information, see pages 45-46.

Indents

The Indents command sets the distance that lines are indented
from the margin. You can indent from the left and right margin,
and you can indent the first line of a paragraph. Note that the
Indents command does not change the margin itself. To change
margins, you use the Page Layout command. For more informa-
tion, see pages 46-48.

The Document Menu

The commands in the Document Menu affect the entire docu-
ment. Headers, footers, and page numbers are displayed only on
printed pages, not in your document on the screen. For more
information, see pages 50-58.

Header

The Header command opens the Header document and dialog
box. The text you type in the Header document becomes the
running header when you print the document. The dialog box
options let you include page numbers, change the distance of the
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Footer

Ruler On/Off

Tabs

Page Layout

header from the top of the page, and print the header on page
one. For more information, see pages 51-55.

Footer

The Footer command opens the Footer document and dialog box.
The text you type in the Footer document becomes the running
footer when you print the document. The dialog box options let
you include page numbers, change the distance of the footer from
the bottom of the page, and print the footer on page one. For
more information, see pages 51-55.

Ruler On/Off

The Ruler On command displays the Ruler at the top of the win-
dow. If you have a mouse, you can use the Ruler to set tabs and
paragraph formats. The Ruler Off command hides the Ruler. For

more information, see pages 48-50 and 57-58.

Tabs

The Tabs command sets tabs. You can set left-align tabs or
decimal tabs. Write has preset tabs set at every half inch. The
preset tabs do not appear in the Tabs dialog box or on the Ruler.
For more information, see pages 55-56.

Page Layout

The Page Layout command changes the margins for the printed
page and changes the starting page number. The preset page lay-
out leaves a 1-inch margin at the top and bottom of the page, and
a 1.25-inch margin at the left and right of the page. For more
information, see page 58.



Appendix
Fonts and the Current Printer

This appendix describes how Write uses fonts with different types
of printers.

The fonts provided with Windows are Courier, Helv, and
TMSRMN. Courier is a fixed-space font, and Helv and TMSRMN
are proportional-space fonts. Whether you can use a particular
font with your Write documents depends on the printer(s) you
have installed in Windows.

The Current Printer

When you start Write, the current printer is the printer you speci-
fied when you installed Windows. If you installed more than one
printer in Windows, you can change to a different printer in Write
with the Change Printer command. The printer you change to
becomes the current printer, and Write formats the document for
that printer. Write also sends the document to that printer when
you choose the Print command. For more information on the
Change Printer command, see “Changing the Printer” in Chapter
5, “Printing a Document.” For more information on installing
printers, see Chapter 7, “Using the Control Panel,” in the Micro-
soft Windows User’s Guide.

When you change printers, you may notice a change in the font
names on the Character Menu and in the Fonts command dialog
box. You may also notice that Write displays the text in your
document in a different font. This is because Write uses the fonts
that are available with the current printer. Read the appropriate
section below for information on dot matrix or daisy wheel
printers, or on the Hewlett-Packarde LaserJet printer.

Note On some two-drive floppy disk systems, you may not be
able to use all three of the fonts provided with Windows, even
though your printer supports all three fonts. To see which fonts
you have, look at the font names listed on the Character Menu.
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Dot matrix printers

Daisy wheel printers

Hewlett-Packard
LaserJet printer

For information on deleting one font and adding another,
see “Adding and Deleting Fonts with the Control Panel” in this
appendix.

Dot Matrix Printers

If the current printer is a dot matrix printer, such as the Epson
FX-80 or the IBMe Graphics Printer, the list box in the Fonts com-
mand dialog box displays font choices available. Font names other
than Courier, Helv, and TMSRMN may be in the list box if you
installed additional fonts from the Windows Control Panel, or if
the current printer is an Epson.

Daisy Wheel Printers

If the current printer is a daisy wheel printer, such as the NEC
3550, the list box in the Fonts command dialog box displays the
names of fonts (print wheels) that are available for that printer.
During printing, the Windows Spooler prompts you to change the
print wheel if it encounters a font change in the document.

Hewlett-Packard LaserJet Printer

If the current printer is the Hewlett-Packard LaserJet, look at your
font cartridge to see which fonts are available. When you use the
Fonts command to specify font sizes, be sure to specify a size that
is on your font cartridge.

Adding and Deleting Fonts
with the Control Panel

Normally, you use the fonts that were installed automatically with
Windows. However, you may want to use the Control Panel to
add or delete a font if:

B You obtain a new font for your Windows system and you want
to install it.
¥ You have a two-drive floppy disk system that does not let you

use all three Windows fonts so you need to delete one font to
add another one.
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Note If you have a hard disk system, you will probably not need
to add or delete fonts. If you do want to add or delete a font, you
W\ can select and run CONTROL.EXE in the directory in which you
. installed Windows. Then you choose Add New Font or Delete
Font from the Installation Menu, select a font name in the list box
and choose the Ok button. If you are adding a font, you must
insert the disk with the font before you choose the Ok button.

y

Adding a Font with a Two-Drive System Adding a font with

a two-drive system
When you add a font, you put it on the Windows System disk in

drive B.
To add a font from the Windows Control Panel:

[ If you are using Write, close the Write window.

(2] Insert the Windows Desktop Applications disk in drive A.
[3] From the MS-DOS Executive window, select drive A.

(4] Select and run CONTROLEXE.

[8] Choose Add New Font from the Installation Menu.

You will see a dialog box asking you to insert a disk with the
font you want to add.

(6] Insert the Utilities disk in drive A and choose the Ok button.
W\ You will see a dialog box with a list of the available fonts.
' Select the font you want to add and choose the Ok button.

You will see a dialog box asking where you want Windows to
put the font.

Type b: and choose the Ok button.
Windows puts the font on the System disk in drive B.

[s] When Windows is finished installing the font, remove the
Utilities disk.

fid If you were using Write, put the Write disk back into drive

A and select and run WRITE.EXE in the MS-DOS Executive
window.

Write will show the new font in the list box for the Fonts
command.
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Deleting a font with
a two-drive system

Deleting a Font with a Two-Drive System
To delete a font from the Windows Control Panel:

(1 If you are using Write, close the Write window.
[2] Insert the Windows Desktop Applications disk in drive A.
[3] From the MS-DOS Executive window, select drive A.
Select and run CONTROL.EXE.
[8] Choose Delete Font from the Installation Menu.
You will see a dialog box with a list of available fonts.
(6] Select the font you want to delete and choose the Ok button.

You will see a dialog box asking which disk you want to delete
the font from.

Type b: and choose the Ok button.
Windows deletes the font from the System disk in drive B.

If you were using Write, select and run WRITE.EXE in the
MS-DOS Executive window.

Note Other applications running with Windows, such as Card-
file, normally use the Courier font. If you delete Courier, Win-
dows substitutes its system font in those applications. With the
system font, the font on your screen may not match the font
used by your printer.



1 1/2 Space command 45-46, 101

Access See Microsoft Access
Add New Font command 105
Alignment
footer 54
header 54
number See Decimal tab
paragraph See Paragraph
tabs
left-align 55, 102
right-align 56
ALT key
command selecting 3
menu opening 90
mouse combination 25
ALT-PRINTSCREEN
Lotus 1-2-3 chart copying 67
Microsoft Access text copying 69
ALT-SPACEBAR 3, 91, 93
ALT-TAB 52
Application
closing 94
copying between 23
moving between 23
multiple applications running 60
pasting
Clipboard use 21, 60-61
Lotus 1-2-3 chart 67-68
Microsoft Access text 68-70
Microsoft Multiplan data 64-66
Microsoft Word text 76-78
Windows Paint graphics 21, 62-64
Windows Write text 74-76, 79
running, memory requirements 60
Arrows (»>), page break character 84, 95
Asterisk (*), footnote reference 77

BACKSPACE key
paragraph mark deleting 44
SHIFT key combination See SHIFT-BACKSPACE
text deleting 20
typing correction 14

Backup document 10, 95

.BAK extension 10

Bold command 92, 99

Bold style
formatting command 99
shortcut key 35, 92, 99
Windows Write/Microsoft Word

compatibility 78

Centered command
footer alignment 54
header alignment 54
paragraph alignment 44-45, 100
Change command 29-31, 98
Change Printer command 86-87, 95
Character
formatting See Formatting
highlighting 16
number in document 9
search character 27-28
style See Formatting
Character Menu commands 34, 98-100
Chart See Graphics; Picture
Clipboard
applications pasting 21, 60-61
contents
changing 64
format preservation 26
viewing 21, 60-61
description 21, 60-61
text
copying 23, 25
cutting 25
inserting 22, 96
moving 23
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Clipboard (‘continued)
text (continued)
pasting 21
CLIPBRD.EXE 21, 60
Close command
application closing 94
dialog box closing 28, 30
Windows Write window closing 11
Command
1 1/2 Space 45-46, 101
Add New Font 105
Bold 92, 99
Centered
footer alignment 54
header alignment 54
paragraph alignment 44, 100
Change 29-31, 98
Change Printer 86-87, 95
Character Menu 34, 98-100
Close
application closing 94
dialog box closing 28, 30
Windows Write window closing 11
Copy
disabled 96
Microsoft Multiplan selection copying 65
shortcut key 92
text copying between documents 26
text copying within document 24-25, 96
Windows Paint selection copying 62
Windows Write text copying 74-75
WRITE.EXE copying ix
COPY ix
Cut
disabled 96
shortcut key 92
text deleting 20-21, 96
text moving between documents 25
text moving within document 23
Delete Font 106
Document Menu 50, 101-102
Double Space 45-46, 101
Edit Menu 96-97
Enlarge Font
font size enlarging 37-38, 100
shortcut key 92
execution
keyboard procedure 3, 90
mouse procedure 3, 91
File Menu 94-95

Command (continued)

Find 26-28, 97

Font Names 99 ’ 3
Fonts

font adding 40-41
font changing 37, 39-40
font display 100
font size changing 39-40
font size display 38, 100
Footer
footer setting 51-53, 102
page numbers entry 53
Go To Page
scrolling to specific page 19-20, 86, 98
shortcut key 92
Header
header setting 51-53, 101-102
page numbers entry 53
Icon 94
Indents
hanging indent creating 47-48
paragraph indenting 46-47, 101
Italic 92, 99
Justified 44-45, 101
Left
footer alignment 54
header alignment 54
paragraph alignment 44-45, 100 /N)
Mark 64 \
Move 93
Move Picture 71-72, 96
New 5, 94
Normal
character format removing 98
paragraph format removing 100
shortcut key 92
Open
directory opening 6, 94
disk drive opening 6, 94
document opening 5, 6, 94
PRACTICE.DOC opening 31
Page Layout 58, 102
Paragraph Menu 41-42, 100-101
Paste
Clipboard contents inserting 22, 96
Lotus 1-2-3 chart pasting 68
Microsoft Access text pasting 69
Microsoft Multiplan selection pasting 66
shortcut key 92
text copying between documents 26



Command (continued)

Paste (continued)
text copying within document 24
text moving between documents 25
text moving within document 23
Windows Paint selection pasting 63
Windows Write text pasting 75

Pause 83

Print 82, 95

Reduce Font
font size reducing 37-38, 99
shortcut key 92

Repaginate 84-86, 95

Repeat Last Find
shortcut key 92
text searching 28-29, 97

Resume 83

Right
footer alignment 54
header alignment 54
paragraph alignment 44-45, 100

Ruler Off 48, 57, 102

Ruler On 48, 57, 102

Save
backup document creating 10, 95
document naming 8-9, 95
document saving 8-9, 95
document saving, different versions 9
document saving to different disk drive

10-11, 95

document saving to subdirectory 11, 95
text saving 10

Search Menu 97-98

selecting
keyboard procedure 3, 90-91
mouse procedure 3, 91

shortcut keys 92

Single Space 45-46, 101

Size 93

Size Picture
disabled 96
picture sizing 72-74, 97

Subscript 35, 99

Superscript 35, 99

Tabs 56, 102

Terminate 83

Underline 92, 99

Undo
action undoing 31, 96
footer undoing 53

Index 109

Command (continued)
Undo (continued)
header undoing 53
shortcut key 92
Zoom 94
Control Panel
font adding 104, 105
font deleting 104, 106
CONTROL.EXE 105, 106
Copy command
disabled 96
Microsoft Multiplan selection copying 65
shortcut key 92
text copying
between documents 26
within document 24-25, 96
Windows Paint selection copying 62
Windows Write text copying 74-75
WRITE.EXE copying ix
COPY command ix
Copying
between applications 23
between documents 23, 26
keyboard procedure 24
Lotus 1-2-3 chart 67
Microsoft Access text 69
Microsoft Multiplan selection 65
mouse procedure 25
shortcut key 92
Windows Paint selection 62
Windows Write text 75
within document 24-25
WRITE.EXE ix
Copying text defined 23
Courier 65, 103, 104
CTRL key, mouse combination 19
CTRL-END 16
CTRL-ENTER 84
CTRL-HOME 16
CTRL-LEFT 15
CTRL-PAGE DOWN 15
CTRL-PAGE UP 15
CTRL-RIGHT 15
Current printer See Printer
Cursor See Insertion point moving
Cut command
disabled 96
shortcut key 92
text deleting 20-21, 96
text moving



110 Index

Cut command (‘continued)
text moving (continued)
between documents 25
within document 23

“d, search character 28
Daisy wheel printer 104
Decimal tab 55, 56, 102
Delete Font command 106
DELETE key
Cut command shortcut 92
tabs deleting 56
text deleting 20-21, 96
text moving
between documents 25
within document 23
Deleting
font 104, 106
methods 20
paragraph mark 44
tab
keyboard procedure 56
Ruler procedure 58
text 20-21, 96
Dialog box
Change command
closing 30, 98
display 29
closing
keyboard procedure 3
mouse procedure 91
filling in
keyboard procedure 4
mouse procedure 5
Find command
closing 28, 97
display 27
Fonts command 39
Footer command 52
Go To Page command 20
Header command 52
Indents command 47
moving in 4
Open command 6
Page Layout command 58
Print command 82
Repaginate command 85
Save command 8
selecting 52

Dialog box (continued)
Tabs command 56
DIRECTION keys
insertion point moving 15
picture sizing 73, 97
window moving 93
Directory opening 6, 94
Disk
changing restrictions ix
document disk creating viii
Disk drive opening 6, 94
.DOC extension 9
Document
backup 10, 95
character number display 9
copying between 23, 26
format See Formatting
Microsoft Word use 76-79
moving text between 23, 25
MS-DOS Executive 7
naming 8-9, 95
opening 5, 6, 94
paginating See Paginating
pasting between 21
printing 82-83, 95
replacing 9
saving
backup document 10, 95
frequency 8
procedure 8, 95
text only 10
to different disk drive 10, 95
to subdirectory 11, 95
versions 9
selecting 19
text See Text
versions saving 9
Document disk creating viii
Document extension 9
Document Menu commands 50, 101-102
Dot matrix printer 104
Dotted line, page break character 84
Double Space command 45-46, 101
DOWN key
GOTO key combination See GOTO-DOWN
insertion point moving 15
picture sizing 73
SHIFT key combination See SHIFT-DOWN

J



Edit Menu commands 96-97
Editing
between searches 28-29
Windows Write disk removal restrictions ix
END key
CTRL key combination See CTRL-END
insertion point moving 15
Enlarge Font command
font size enlarging 37-38, 100
shortcut key 92
ENTER key
blank lines inserting 14
command execution 3, 90
paragraph mark inserting 14, 43
picture moving 71
window opening 93
Epson FX-80 printer 104
EsC key
Change command dialog box closing 30, 98
dialog box closing 3
Find command dialog box closing 28, 97
Footer command execution 53
Header command execution 53
menu closing 3, 90

F2 key 24, 26, 92

F3 key 28, 92, 97

F4 key 92, 98

F5 key 35, 92, 98

F6 key 35, 92, 99

F7 key 35, 92, 99

F8 key 35, 92, 99

F9 key 37, 92, 99

F10 key 37, 92, 100

File See Document

File Menu commands 94-95

Filename extension 9

Find command 26-28, 97

Finding See Searching

Font
adding 40-41, 104, 105
changing 36-37, 39
Courier 65, 103, 104
defined 36
deleting 104, 106
display 36, 100
fixed-space 65, 103
Helv 65, 103, 104
Microsoft Word 77

Font (continued)
printer effect 87, 103
printing 40
proportional-space 65, 103
selecting 99, 100
size
display 38, 100
enlarging 37-38, 39-40, 100
reducing 37-38, 39-40, 99
spreadsheet data 65
substitution 106
TMSRMN 103, 104
types 103
Font Names command 99
Fonts command
font
adding 40-41
changing 37, 39-40
display 100
size changing 39-40
size display 38, 100
Footer
alignment 54
defined 51
setting 52-53, 102
undoing 53
Footer command
footer setting 51-53, 102
page numbers entry 53
Windows Write/Microsoft Word
compatibility 77
Footnotes 77
Format Character menu 78
Format Paragraph menu 78
Formatting
See also specific formatting style
character format
display 34
removing 98
saving 34
styles 35
Clipboard contents 26
defined 33
display on screen 98
documents 50-51, 94, 101
elimination 10
fonts See Font
paragraphs
command procedure 41-48
format removing 100

Index 111
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Formatting (continued)
paragraphs (continued)
Ruler procedure 48-50, 102
Windows Write/Microsoft Word
compatibility 77-78
printer change effect 87
style sheet 78

Go To Page command
scrolling to specific page 19-20, 86, 98
shortcut key 92
GOTO key 15, 16
GOTO-DOWN 15
GOTO-LEFT 15
GOTO-PAGE DOWN 16
GOTO-PAGE UP 16
GOTO-RIGHT 15
GOTO-UP 15
Graphics
See also Picture
Microsoft Word noncompatibility 79

Hanging indent 47-48 .
Hard-disk system
font
adding 105
deleting 105
saving to different disk drive 10
Windows Write running ix
Header
alignment 54
defined 51
example 54-55
setting 52-53, 101-102
undoing 53
Windows Write/Microsoft Word
compatibility 77
Header command
header setting 51-53, 101-102
page numbers entry 53
Helv 65, 103, 104
Hewlett-Packard LaserJet printer 104
Highlighting text 16
HOME key
CTRL key combination See CTRL-HOME
insertion point moving 15
Hyphen (-), Windows Write/Microsoft Word
compatibility 78

IBM Graphics printer 104
Icon command 94
Icon expanding 93, 94
Indenting
command procedure 46-47, 101
hanging indent 47-48
Ruler procedure 49
Indents command
hanging indent creating 47-48
paragraph indenting 46-47, 101
INSERT key
Paste command shortcut 92
text copying
between documents 26
within document 24
text inserting 22, 96
text moving
between documents 25
within document 23
Inserting
Clipboard contents 22, 96
methods 22
page breaks 84
page number 53
paragraph mark 42-43
text 22, 96
Insertion point moving
keyboard procedure 15-16
mouse procedure 17
Italic command 92, 99
Italic style
formatting command 99
shortcut key 35, 92, 99
Windows Write/Microsoft Word
compatibility 78

Justified command 44-45, 101

Key
See also specific key
command shortcut keys 92
Keyboard
command
execution 3, 90
selecting 3, 90-91
dialog box
closing 3
filling in 4



Keyboard (continued)
insertion point moving 15-16
menu selecting 90
picture

moving 71, 96
selecting 71, 72
sizing 72-73, 97
scrolling 15-16
System Menu opening 3, 91, 93
tabs deleting 56
text
copying 24
highlighting 16
moving 23-24
selecting 16-17
window moving 93

Left-align tab 55, 102
Left command
footer alignment 54
header alignment 54
paragraph alignment 44-45, 100
LEFT key
CTRL key combination See CTRL-LEFT; SHIFT-
CTRL-LEFT
GOTO key combination See GOTO-LEFT
insertion point moving 15
menu selecting 90
picture
moving 71, 96
sizing 73
SHIFT key combination See SHIFT-CTRL-LEFT;
SHIFT-LEFT
Line break 87
Line selecting
keyboard procedure 16
selection bar procedure 18-19
Line spacing
1 1/2 space 45-46, 101
command procedure 45-46, 101
double space 45-46, 101
Ruler procedure 49
single space 45-46, 101
Windows Write/Microsoft Word
compatibility 77
Lotus 1-2-3 67-68

Margin
changing 58, 102
Windows Write/Microsoft Word
compatibility 77
Mark command 64
Memory
multiple applications running 60
multiple windows opening 7
Menu
closing 3, 90
opening 3, 90
selecting
keyboard procedure 90
mouse procedure 91
Message, printing 83
Microsoft Access 68-70
Microsoft Multiplan 64-66
Microsoft Word 76-79
Mouse
ALT key combination 25
command
execution 3, 91
selecting 3, 91
CTRL key combination 19
dialog box
closing 91
filling in 5
selecting 52
insertion point moving 17
left button use vii
menu selecting 91
picture
moving 72, 96
selecting 72, 73
sizing 73-74, 97
Ruler See Ruler
scrolling 17
System Menu opening 91, 93
text
copying 25
moving 25
selecting 18
window moving 93
Move command 93
Move Picture command 71-72, 96
Moving
insertion point
keyboard procedure 15-16
mouse procedure 17
page break 86
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Moving (continued)
picture
keyboard procedure 71, 96
mouse procedure 72, 96
text
between applications 23
between documents 23, 25
defined 23
keyboard procedure 23-24
mouse procedure 25
within document 23-24, 25
window 93
MS-DOS Executive document 7
Multiplan See Microsoft Multiplan

Naming documents 8-9, 95

NEC 3550 printer 104

New command 5, 94

Normal command
character format removing 98
paragraph format removing 100
shortcut key 92

Number alignment See Decimal tab

Open command
directory opening 6, 94
disk drive opening 6, 94
document opening 5, 6, 94
PRACTICE.DOC opening 31

"p, search character 28
Page break See Paginating
PAGE DOWN key

CTRL key combination See CTRL-PAGE DOWN
GOTO key combination See GOTO-PAGE DOWN

scrolling 16
Page Layout command 58, 102
Page number See Paginating
PAGE UP key
CTRL key combination See CTRL-PAGE UP
GOTO key combination See GOTO-PAGE UP
scrolling 16
Paginating
automatic 84
defined 84
methods 19
page break

Paginating (continued)
page break (continued)
characters 84, 95
inserting 84
moving 86
preview 84, 95
printer change effect 87
searching 28
page number
header position 101
inserting 53
starting page specification 58, 102
Windows Write/Microsoft Word
compatibility 77
Print command 95
Repaginate command 85, 95
Paint See Windows Paint
Paragraph
alignment
centered 44-45, 100
justified 44-45, 101
left 44-45, 100
right 44-45, 100
Ruler procedure 49
beginning See Paragraph mark
formatting See Formatting
hanging indents 47-48
indenting
command procedure 46-47, 101
hanging indents 47-48
joining 44
line spacing See Line spacing
selecting 19
Paragraph mark
deleting 44
inserting 42-43
searching 28
Paragraph Menu commands 41-42, 100-101
Paste command
Clipboard contents inserting 22, 96
Lotus 1-2-3 chart pasting 68
Microsoft Access text pasting 69
Microsoft Multiplan selection pasting 66
shortcut key 92
text copying
between documents 26
within document 24
text moving
between documents 25
within document 23



Paste command (continued)
Windows Paint selection pasting 63
Windows Write text pasting 75

Pasting
applications to Windows Write 60
between applications 21
between documents 21
Clipboard contents 21, 22, 60-61
Lotus 1-2-3 chart 67-68
Microsoft Access text 68-70
Microsoft Multiplan data 64-66
Microsoft Word text 76-78
shortcut key 92
Windows Paint graphics 21, 62-64
Windows Write text 74-76, 79

Pause command 83

Picture
moving

keyboard procedure 71, 96

mouse procedure 72, 96
selecting

keyboard procedure 71, 72

mouse procedure 72, 73
sizing

keyboard procedure 72-73, 97

mouse procedure 73-74, 97

PRACTICE.DOC 31, 43, 54-55

Print command 82, 95

Printer
changing 86-87, 95
current printer 86-87, 103-104
daisy wheel 104
dot matrix 104
font, effect 87, 103
format, effect 87
listing 87, 95

Printing
canceling 83
document 82, 95
font varieties 40
message 83
pausing 83
resuming 83

Question mark (?), wildcard character 27, 97

Reduce Font command
font size reducing 37-38, 99

Index 115

Reduce Font command (continued)
shortcut key 92
Repaginate command 84-86, 95
Repeat Last Find command
shortcut key 92
text searching 28-29, 97
Resume command 83
Right-align tab 56
Right command
footer alignment 54
header alignment 54
paragraph alignment 44-45, 100
RIGHT key
CTRL key combination See CTRL-RIGHT; SHIFT-
CTRL-RIGHT
GOTO key combination See GOTO-RIGHT
insertion point moving 15
menu selecting 90
picture
moving 71, 96
sizing 73
SHIFT key combination See SHIFT-CTRL-RIGHT;
SHIFT-RIGHT
Ruler
display 48, 57, 102
hiding 48, 57, 102
indenting 49
line spacing 49
paragraph
alignment 49
formatting 48-50, 102
tabs
deleting 58
setting 57-58, 102
Ruler Off command 48, 57, 102
Ruler On command 48, 57, 102
Running footer See Footer
Running head See Header

Save command
backup document creating 10, 95
document naming 8-9, 95
document saving
procedure 8-9, 95
to different disk drive 11, 95
to subdirectory 11, 95
versions 9
text saving 10
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Saving
backup document 10, 95
character formats 34
documents
frequency 8
procedure 8, 95
to different disk drive 10, 95
to subdirectory 11, 95
versions 9
frequency 8
text 10
Scrolling
defined 15
keyboard procedure 15-16
mouse procedure 17
specific page 19-20, 86, 98
Search Menu commands 97-98
Searching
case options 97
characters 27-28
direction 97
editing between searches 28-29
page breaks 28
paragraph mark 28
repeating 28, 97
replacing found text 29-31, 98
tab character 28
text 26-28, 97
white space 28
whole word option 97
wildcard character 27, 97
Selecting
command
keyboard procedure 3, 90-91
mouse procedure 3, 91
defined 15
dialog box 52
document 19
fonts 99, 100
line 16, 19
menu
keyboard procedure 90
mouse procedure 91
paragraph 19
picture
keyboard procedure 71, 72
mouse procedure 72, 73
text
keyboard procedure 16-17
mouse procedure 18

Selecting (‘continued)

text (continued)

selection bar procedure 18-19

word 16, 18
Selection bar 18-19
SHIFT key

mouse combination 18, 19

text highlighting 16
SHIFT-ALT, mouse combination 25
SHIFT-BACKSPACE 20
SHIFT-CTRL-LEFT 16
SHIFT-CTRL-RIGHT 16
SHIFT-DOWN 16
SHIFT-ESC 92
SHIFT-LEFT 16
SHIFT-RIGHT

character selecting 16

picture selecting 71, 72
SHIFT-UP 16
Shortcut keys 92
Single Space command 45-46, 101
Size box 93
Size command 93
Size icon 93, 97
Size Picture command

disabled 96

picture sizing 72-74, 97
SPACEBAR  See ALT-SPACEBAR
Special characters 27-28
Spooler 83
Spreadsheet data 65
Standard application pasting 60
Style sheet format 78
Subdirectory, saving to 11, 95
Subscript

creating 35, 99

defined 35,

Windows Write/Microsoft Word

compatibility 78

Subscript command 35, 99
Superscript

creating 35, 99

defined 35

Windows Write/Microsoft Word

compatibility 78

Superscript command 35, 99
System Menu

commands 93-94

opening

keyboard procedure 3, 91, 93



System Menu (continued)
opening (‘continued)
mouse procedure 91, 93

“t, search character 28
Tab
decimal tab 55, 56, 102
deleting
keyboard procedure 56
Ruler procedure 58
left-align 55, 102
new document 94
preset 55
right-align 56
setting
command procedure 56, 102
Ruler use 57-58, 102
Windows Write/Microsoft Word
compatibility 77
Tab character searching 28
TAB key 4
Tabs command 56, 102
Terminate command 83
Text
changing 29-31
copying See Copying
deleting 20-21, 96
formatting See Formatting
highlighting 16
inserting 22, 96
moving
between documents 23, 25
defined 23
keyboard procedure 23-24
mouse procedure 25
saving 10
searching See Searching
selecting
keyboard procedure 16-17
mouse procedure 18
selection bar procedure 18-19
typing 14, 22
typing over 20
TMSRMN 103, 104
Two-drive system
font
adding 105
deleting 106
support 103

Index 117

Two-drive system (continued)
saving to different disk drive 10
Windows Write running viii-ix

Typing 14, 22

Underline
shortcut key 35, 92
text underlining 99
Windows Write/Microsoft Word
compatibility 78
Underline command 92, 99
Undo command
action undoing 31, 96
footer undoing 53
header undoing 53
shortcut key 92
upP key
GOTO key combination See GOTO-UP
insertion point moving 15
picture sizing 73
SHIFT key combination See SHIFT-UP

“w, search character 28
White space searching 28
Wildcard character 27, 97
WIN application
defined 62
pasting to Windows Write 60
Window
clearing 94
closing 91
moving 93
opening
keyboard procedure 93
mouse procedure 93
multiple windows 7
shrinking 93, 94
sizing 93
zooming 94
Windows Paint
description 62
pasting from Windows Write 74-76
pasting to Windows Write 62-64
Windows Write
Microsoft Word compatibility 76-79
package contents viii
pasting from Lotus 1-2-3 67-68
pasting from Microsoft Access 68-70
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Windows Write (continued)
pasting from Microsoft Multiplan 64-66
pasting from Windows Paint 62-64
pasting to applications 74
pasting to Windows Paint 74-76
running
hard-disk system ix
two-drive system viii-ix
screen 2
window
closing 11
multiple windows opening 7
Windows Write disk, removal restrictions ix
Word
highlighting 16
Microsoft Word See Microsoft Word
selecting 16, 18
Wordwrap defined 14
Write See Windows Write
WRITE.EXE
copying ix
multiple windows opening 7
Windows Write running viii-ix, 105, 106

Zoom command 94



